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About This Manual

The COLD Handbook supports COLD for IBM® FileNet® Image 
Services and describes how to use the COLD software. (COLD is an 
acronym for Computer Output to Laser Disk.) We assume that you 
have a working knowledge of UNIX® or Windows® Server operating 
systems and workstations, and an understanding of the FileNet 
software methods of document entry, scanning, indexing, retrieving, 
and printing operations. 

Document revision history    

What to Read First
If you are not familiar with the FileNet COLD functionality, you should 
read Chapter 1, “Overview,” on page 20. This chapter describes the 
basics of COLD processing.

The “Glossary,” on page 197 explains terms used in this manual.

IS version Date Comment

4.1.2 Nov. 2008 Initial release.
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Related Publications 

This manual includes specific information about using COLD, but does 
not detail the basics of operating the FileNet system. The manuals 
listed below provide more detailed information on other applications 
that can help you to use COLD more efficiently. For information on 
accessing these documents, see the next section.

• Image Services System Administrator’s Handbook

• Image Services System Administrator’s Companion for UNIX

• Image Services System Administrator’s Companion for Windows 
Server

Accessing IBM FileNet Documentation
To access documentation for IBM FileNet products:

1 Navigate to the Information Management support page 
(www.ibm.com/software/data/support).

2 Select the appropriate IBM FileNet product from the “Select a cate-
gory” list.

3 On the Product Support page, click Documentation and then click 
Product Documentation.

4 On the Product Documentation page, locate the document you need, 
then cick the icon in the appropriate release column to access the doc-
ument.


http://www.ibm.com/software/data/support
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Conventions Used in this Manual
The following paragraphs explain some of the conventions that we 
used in this manual.

Keyboard & Mouse Instructions

Assume that when we tell you to click on a button or object, we are 
referring to the left mouse button, unless we instruct you otherwise.

We indicate commands, values, and so on that you are to enter from 
your keyboard by using the following typeface:

Type this.

Page Headers

Except for the first page of a chapter, you can tell where you are in the 
manual by looking at the top right-hand corner of a page. There, you 
can find the chapter name (on top) and the current main heading. 

UNIX and Windows Server Flags

These flags have been added to appropriate sections of this manual to 
help you find required information more quickly.

Cautions, Notes, & Tips

To call attention to important information, you will see the following 
message types:

UNIX

WIN
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CAUTION Signals possible unexpected consequences of an action, such as loss 
of data or time.

Note Draws your attention to essential information that you should be sure 
to read.

Tip Introduces an idea that might make your work easier.

IBM FileNet Education
IBM FileNet provides various forms of education. Please visit Global 
Learning Services on IBM’s Web site at (www-306.ibm.com/
software/sw-training/).

Feedback
We value your opinion, experience, and use of our products. Please 
help us improve our products by providing feedback or by completing a 
consumability survey. 

Documentation feedback

Send comments on this publication or other IBM FileNet Image Ser-
vices documentation by e-mail to comments@us.ibm.com. Be sure 
to include the name of the product, the version number of the product, 
and the name and part number of the book (if applicable). If you are 
commenting on specific text, include the location of the text (for exam-
ple, a help topic title, a chapter and section title, a table number, or a 
page number). 

http://www-306.ibm.com/software/sw-training/
http://www-306.ibm.com/software/sw-training/
mailto:comments@us.ibm.com
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Product consumability feedback

Help us identify product enhancements by taking a Consumability Sur-
vey (http://www-306.ibm.com/software/data/info/consumability-
survey/). The results of this comprehensive survey are used by prod-
uct development teams when planning future releases. Although we 
are especially interested in survey responses regarding the most re-
cent product releases, we welcome your feedback on any of our prod-
ucts.

The survey will take approximately 30 minutes to complete and must 
be completed in a single session; there is no option to save a partially 
completed response. 

http://www-306.ibm.com/software/data/info/consumability-survey/
http://www-306.ibm.com/software/data/info/consumability-survey/
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1
1Overview

Typically, you enter documents into the FileNet system by scanning 
them and then entering the index values associated with each docu-
ment to facilitate later retrieval. This is usually done using a document 
entry program. The FileNet system stores the scanned images on 
optical disk and adds the index values into a relational database. You 
can then use the index values to retrieve and display the images. 

However, when the data is ASCII or EBCDIC text on magnetic tape or 
disk, you can import it directly into the FileNet system without scanning 
or manual indexing. To do this, you read the data using the FileNet 
COLD (Computer Output to Laser Disk) program. COLD is a document 
entry alternative to scanning.
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COLD Features
When the COLD data has been indexed and stored on optical disk, you 
can retrieve, display, and print COLD documents just like any other 
scanned document. As a printing and display option, you can superim-
pose COLD data on a scanned background image. For example, you 
could use a scanned invoice form as a background image (template) 
and superimpose the COLD data on the background image to create 
an invoice.

With COLD you can view text data as document images at a worksta-
tion rather than referring to paper print-outs or microfiche, thus 
reducing your need for traditional storage space for paper or film. Also, 
you can retrieve COLD documents more quickly and easily than you 
can paper documents.

Some other features of COLD are:

• COLD is totally integrated with the FileNet imaging and workflow 
management software. 

• COLD permits the use of background templates in formatting the 
text data. With this feature, you can print or display your data on the 
equivalent of a preprinted form.

• COLD automatically creates a maximum of three different tables of 
contents for each document, which you can use for reference such 
as a list of telephone numbers.

• Because text files are small compared to images, COLD data 
requires relatively little space on optical disk.
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COLD Basic Concepts
The following pages briefly describe some of the basic concepts that 
you need to know to work with the COLD software.

Background Templates

A background template is a committed FileNet image that supplies 
fixed text and graphics to enhance the data. COLD superimposes the 
data that it processes onto the background template image.

You can specify one template for the table of contents and other tem-
plates for different pages of data.
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Document Length Control

A COLD document can have as many as 1,000 pages. If COLD does 
not encounter an end-of-document indicator after 1,000 pages, it auto-
matically creates a new document. With COLD, you can designate 
either fixed- or variable-length documents. A document can have a 
maximum of three tables of contents. (Sorting the data for multiple 
tables of contents using different data on each one can save time 
searching for records.) For information on tables of contents, see 
“Table of Contents” on page 24. 

Indexing

You can specify index information as a constant or a variable. A con-
stant index value does not change from document to document, such 
as the run date. You supply the constant index values. 

A variable index value does change from document to document, such 
as an invoice total. For COLD to extract a variable, you must supply its 
exact location in the data. If the data occurs in a different location on 
every page, you must supply an identifying keyword and the associ-
ated coordinates for each occurrence. COLD searches for the keyword 
literal and the coordinates to extract the variable indexing value. 

To see if the correct indexing values are present, you can run the Pre-
view Documents program. (For more details on indexing, see “Specify 
Indexing Information” on page 84. For more details on previewing 
documents, see “Preview Documents” on page 134.)
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Table of Contents

You can use a table of contents for locating data in the document or as 
a handy reference, such as a list of customer names. COLD can gen-
erate a maximum of three tables of contents for each document by 
looking for a sequence of characters, such as a name, in the same 
place on each page. Each time the sequence of characters changes, 
COLD adds the new characters and corresponding document page 
number to the table of contents. 

If you specify multiple tables of contents, you might use one for a list of 
customer names, another for zip codes, and a third for products pur-
chased. For information on tables of contents, see “Specify Filtering, 
Multiple Templates, & Tables of Contents” on page 106. 

Formatting COLD Data

You can format your COLD data for printing and displaying by selecting 
fonts and by setting lines-per-inch and margins.

You can also use COLD’s channel control character feature to control 
formatting. Your installation might already be using channel control 
characters (sometimes called printer control characters) in the data 
that you import to COLD. The channel control character resides in the 
first column of a line, and can specify paging, line spacing, vertical 
positioning of text on a page, and line filtering. Use the Define Channel 
Control File application to indicate to COLD what channel control char-
acters are in your data and assign data formatting to those characters.
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Unattended Operation

You can set COLD to do most of its data processing at night or at 
another time when system activity is low. You can use the 3770 
daemon program for this purpose. 

The daemon program runs in the background and opens and searches 
a specified directory for files containing COLD data. The default direc-
tory the daemon searches is /fnsw/local/tmp/3770, and the default 
search (polling) frequency is once every 60 seconds. 

Upon encountering a COLD data file, the daemon program starts the 
import process. Files processed by COLD in this way could have been 
transferred to an Image Services server from a mainframe by way of 
RJE/SNA services, ftp, rcp, or other methods.

For more information about the COLD 3770 daemon and unattended 
operation see “Automating COLD” on page 154.

Document Class Security

A COLD document acquires the security of its document class. After 
committal, you can change the security of a COLD document by using 
the Maintenance option in the Query Match Report, as with any other 
document. See the Desktop documentation or help system for details. 
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Preview Documents

You can preview pages before beginning an actual COLD import job to 
ensure that the import process runs correctly. Select COLD’s Preview 
Documents function from the COLD Main Menu to display the preview 
windows.
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Multi-byte Character Support
You can import multi-byte data, use multi-byte characters in certain 
indexes, and use COLD Preview to align multi-byte data. 

About “Characters”

In this manual, the term “character” usually means the single-byte 
English language letter, symbol, or digit. However, in this release of the 
FileNet Image Services software, COLD also provides partial support 
of multi-byte (16-bit NLS) characters for use with the Japanese lan-
guage. 

Japanese Data

Although this version of COLD and Image Services supports the use of 
multi-byte Japanese data, any search string, literal, document class, 
index value, report ID name, etc., must be in English. 

Requirements for COLD Multi-byte Character Support

UNIX Platforms

In order to commit or import COLD multi-byte documents to UNIX plat-
forms, the Japanese locale must be installed and the LC_CTYPE envi-
ronment variable must be set to point to the Japanese locale. 

For instructions, contact your platform hardware vendor.

Windows Server Platforms

The Japanese Windows Server Operating System must be installed.
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Limitations

The following list describes what you can, and cannot, do in COLD with 
multi-byte data.

• Multi-byte characters are supported only on Combined servers; 
AIX®, HP-UX, Solaris, and Windows Server.

• COLD Preview of Japanese data is only supported on Windows 
Servers that have the Japanese Windows Server Operating 
System installed.

• All keyboard input to COLD must be single-byte.

• All jobs must be fixed length.

• All jobs must be variable pages.

• All COLD jobs support a maximum of 255 bytes per line.

• The Document source index type supports multi-byte data.

• For multi-byte data, only the ‘length’ index identification method is 
supported. The Token Concatenation and Filter Mask identification 
methods are not supported. 

• If the index value is a constant, the literal must be a single-byte 
character string.

• If the ‘Keyword’ feature is used, the keyword must be a single-byte 
character string.

Not Supported

The following is a list of items that are not supported in COLD with 
multi-byte characters.
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• Multi-byte characters are not supported in the Table of Contents.

• Page Compression is not supported for multi-byte data.

• No multi-byte translation, for example EBCDIC to ASCII, is sup-
ported.



November 2008 COLD Handbook, Release 4.1.2 30

2
2Preparing for an Import Job

This chapter specifies what information you need to supply to COLD’s 
various job files before beginning an import job. 

The following flow chart explains the various requirements for running 
an import job. 

The file name examples used in this
manual are noted in the appropriate process.

Verify/Preview data
(Optional)

TAPE
or

DISK FILE

Begin COLD import

Use Database Maintenance to:

Define index fields

SprngWtr
Define document
classes

Define channel
control file

FN_DEFAULT

Define import job

Acctng

Define report format(s)

CustStmt
CoolWtr
RegBrdr

Prepare background
templates
(Optional)

The arrows in this illustration indicate the relationships between the
various files required to process an import job. For example: document
classes must be defined before defining a report format, and the report
formats must be completed before defining the import job.



Preparing for an Import Job

How to Begin

November 2008 COLD Handbook, Release 4.1.2 31

How to Begin
Before you can create the job files for a COLD session, you must have 
a number of facts on hand. If you copy and then fill in the prepared 
checklist on page 189, you can save it for a record of each import job’s 
attributes in case you need to re-create job files. The following list gives 
you an idea of the information that you need: 

Tip You can also save printouts of the job files.

❑ The password to the console and password to the FileNet system. 

❑ The background template file name, or the document ID of the im-
age if you are defining a new background template.

❑ The channel control file name.

❑ The channel control characters that are used on the data at your 
installation.

❑ The number of pages per document, the number of columns per 
page, the number of lines per page, and the number of characters 
per line. 

❑ The line and column numbers of the data that COLD will use as a 
report identifier, table of contents key, and indexing information.

❑ The document class name that you will associate with your COLD 
output. 
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At least one FileNet document class must be available for COLD 
committals. The document class defines the index values that you 
can use later to retrieve the documents that you commit to optical 
storage. Although you can specify where COLD finds the index, or 
its value if it is a constant, you cannot change the index itself. For 
example, you can specify that an index named Invoice# appears in 
line one, column 60, but you cannot change Invoice# to 
Employee#. If you need an index named Employee#, you must add 
it to the document class. 

You create or modify the document class and indexes in the Image 
Services Database Maintenance program. In this handbook, we 
assume that the appropriate document class—complete with index 
definitions—already exists and that you know the document class 
name.

If you do not know the name of the document class to use for your 
COLD documents, please see your system administrator. If you 
want to create or modify a document class (for example, to add or 
change an index), refer to the Image Services System Adminis-
trator’s Handbook for your system. To download IBM FileNet docu-
mentation from the IBM support page, see “Accessing IBM 
FileNet Documentation” on page 16.

❑ The input data format—whether it is ASCII, EBCDIC, or some other 
character set.

❑ The full path name of the file that contains the COLD data to pro-
cess.

❑ The input data source—whether it comes from tape or disk.
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❑ If you plan to use the variable-length record feature, you need to 
know the type of end-of-line characters (carriage return, line feed, 
etc.) used in your data.

Starting COLD on UNIX

To use the COLD software on UNIX-based platforms, you need to log 
on to the FileNet system as described below. 

Note Commands on UNIX-based systems are case-sensitive, whereas com-
mands on Windows Server systems are not.

1 At the FileNet server logon prompt, enter the command below, and 
then press the Enter key.

fnsw

The system displays the fnsw password prompt.

2 At the fnsw password prompt, enter your password, and then press the 
Enter key. 

The system displays the system prompt.

3 At the system prompt, enter the command below, and then press the 
Enter key.

Xapex

The system displays the User Name and password dialog box.

UNIX



Preparing for an Import Job

How to Begin

November 2008 COLD Handbook, Release 4.1.2 34

4 In the User Name field, enter your user name, and then press the Tab 
key to move to the Password field.

5 Enter your password, and then press the Enter key, or click OK. The 
FileNet Application Executive window displays.

6 From the FileNet Application Executive window, select COLD. This dis-
plays the COLD Main Menu.

Starting COLD on a Windows Server 

On a Windows Server system, follow the procedure below to log on to 
the FileNet system. 

1 From the Start menu, select Programs/FileNet Image Services/Server 
Applications. This opens the Server Applications dialog box and the 
Logon dialog box.

2 In the Logon dialog box’s User Name field, enter your user name and 
then press the Tab key to move to the Password field.

3 Enter your password and press the Enter key. You can also click on the 
OK button. This opens the Applications Executive dialog box.

4 Select the Applications menu to display a list of FileNet applications.

5 Select COLD to display the COLD Main Menu.

Tip Instead of going through these steps, you can create an Apex icon on 
your desktop to make logon easier. See your system manual for more 
information.

WIN



Preparing for an Import Job

The COLD Main Menu

November 2008 COLD Handbook, Release 4.1.2 35

The COLD Main Menu
The remainder of this chapter discusses the first four Main Menu items 
in the order that they appear on the menu. You’ll use the first four Main 
Menu items to create the job files that are required for running an 
import job. The organization of the Main Menu is a good guideline for 
the order in which you complete the requirements for running an import 
job. The last three Main Menu items describe the various aspects of 
running an import job and are discussed in the next chapter, “Running 
an Import Job” on page 134. Each menu item, except Preview Docu-
ments, can create an ASCII file, which you can edit and print. 

An illustration of the COLD Main Menu is shown below. 
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COLD Application Commands at System Prompt

The commands below mirror the functions on the COLD Main Menu. At 
times you might find it convenient to run the COLD applications from 
the system prompt. The commands are the same on all platforms. You 
can usually find these commands in the directory /fnsw/bin. 

Define Background Template
You can enhance data output and display by specifying that COLD use 
a background template. The background template displays with the 
data and can contain text and graphics (such as your logo). Using a 
background template is optional; you can print, process, and view 
COLD data without a background template. If you do not plan to use a 
background template, you can skip to “Define Channel Control File” 
on page 42. This section explains how to create templates, and how to 
use them with your data. 

Description Command

COLD Main Menu Xcold_menu

Define Background Template Xcold_tem

Define Channel Control File Xcold_ch

Define Report Format Xcold_rpt

Define Import Job Xcold_job

Preview Documents Xcold_ver

Import Documents Xcold_imp

View Import Log Xcold_log
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About Templates

The background template is a committed FileNet image that provides 
constant text or graphics upon which COLD superimposes the data for 
displaying or printing. A template can act as a preprinted form, such as 
an invoice or purchase order. 

Like all FileNet images, the background template belongs to a docu-
ment class. However, because you use it strictly as a background form 
for COLD data, the template does not use indexing. Therefore, you 
would not normally assign index values to the document class used for 
your COLD background templates. 

Display & PrintTemplate
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Data

1 A c c t  1 0 2 8

     2 8 8 0 5 1
     1 0 / 1 2 / 2 0 0 0
     S p r i n g  W a t e r
 R t e  2 3 1 - 0 0 2
     5  g a l l o n
     2
     1 0 / 2 6 / 2 0 0 0

            0 0 . 0 0
            2 7 . 0 0
            2 7 . 0 0
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The Background Template Definition File 

When you use the Define Background Template function from the 
COLD Main Menu to select a background template, COLD creates a 
background template definition file on your Image Services server (a 
text file). This definition file resides in the /fnsw/local/cold/templates 
directory. The file contains the document ID of the committed image 
that you select as a template. Later, when defining your Report 
Format, you supply this file name. If you do not have this information, 
please see your system administrator. 

COLD refers to this definition file while processing your data, reads the 
document ID, then retrieves the image file from optical storage or 
cache. COLD then uses this image as a background template for your 
COLD data exactly as you specify when you define the Report Format 
for your data. You can see a list of all background template definition 
files in the Define Background Template window. See “Select a Back-
ground Template” on page 40 for more information about displaying 
the list of templates.

The Background Template Image

You do not create templates in the COLD application. The template 
must be a previously-stored (committed) image. The background tem-
plates must be TIFF images in resolutions of 100, 200, and 400 dots 
per inch (dpi). For best results when printing, use templates scanned in 
at 200 or 400 dpi. The following procedures explain what you must do 
to use 400 dpi templates. 
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To use a 400 dpi background template:

If you are using a 400 dpi background template, you must perform the 
following steps for your output to print correctly: 

1 In /fnsw/local/cold/config (for UNIX), or, \fnsw_loc\cold\config (for Win-
dows Server), create a text file named: 

COLDresolution.txt

Note This file must have a .txt extension for COLD to recognize the file and 
be viewed properly in the COLD Preview display screen.

2 Open the file and enter the resolution value:

400

Create a New Background Template

Before defining a template, you might want to print the COLD input 
data file from your mainframe or tape to a standard line printer, and 
then create a layout grid to locate the data (lines and columns). This 
procedure can help you match the background data to your template 
and also help you identify which line and column numbers you want 
COLD to use when extracting values and formatting pages.

You can also use the information in “Preview Seek Methods & String 
Location” on page 139 to locate the first occurrence of specific data 
on a page. This method is only of value when the field uses formatted 
data. Some fields require preformatted data for the search to work.
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Select a Background Template

The following paragraphs explain how to select a background template 
to use with your data.

1 On the COLD Main Menu, click the Define Background Template but-
ton to display the Define Background Template dialog box. 

2 Click the List button next to the Template Name field. COLD displays 
the Selection Box containing a list of all background template files 
available on this system.

3 Select a background template from the list. 

If you are naming a new template, enter a name in the Selection field. 
Use standard file-naming conventions. The name can’t be all numeric, 
and the only special character that you can use is the underscore ( _ ). 
The maximum length of the Selection field is 14 characters.
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4 Click the OK button. COLD returns you to the Define Background Tem-
plate window. 

• If you are defining a new template, continue to the end of these 
procedures to enter its description and document ID. 

• If you have selected an existing template, you can close the Define 
Background Template window and return to the COLD Main Menu 
where you can continue defining the parameters for your data.

5 In the Description field, enter a description of the background template. 
This makes it easier to select the correct template. The maximum 
length of the Description field is 30 characters.

6 In the Document Number of Template field, enter the document ID 
number of the committed image that you want to use as a background 
template. 

7 From the Define Background Template window’s File menu, select 
Save. 

COLD verifies that the image’s document ID is valid and that the image 
document is type IMAGE.
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Delete a Background Template File

The following steps explain how to remove a background template 
from COLD’s list of available templates. 

1 On the COLD Main Menu, click the Define Background Template but-
ton to display the Define Background Template window. 

2 Click the List button next to the Template Name field. COLD displays 
the Selection Box containing a list of all template files available on this 
system.

3 Select the desired background template from the list.

4 From the File menu, select Delete.

Define Channel Control File
This section defines some of the data formatting that you can specify 
using a channel control file. Later sections in this manual explain more 
formatting that you can do using other tools. You should be aware of 
how these other tools and channel control character formatting can 
affect your final data output. Please see “COLD Formatting During 
Data Processing” on page 173.

Before you begin the procedures in this section, collect the data listed 
in “How to Begin” on page 31. 
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About Channel Control Characters

The raw data that COLD processes contains special characters in the 
first column on each line of data. These characters are intended as for-
matting flags for data output and are called channel control (or printer 
control) characters. 

Note The COLD software always assumes that the first character on each 
line of data is a channel control character.

The channel control character indicates what kind of formatting is done 
to that line when it is displayed or printed. For example, a blank in the 
first column might cause a line to be single-spaced. A zero in the first 
column might cause another line to be double-spaced. A hyphen might 
cause a line to be triple-spaced. You can define other characters to 
cause page breaks, vertical spacing, and line deletions.

Channel Control
Characters

1 A c c t  0 9 1 5 8 3
0 F i l e N E T  C o r p .
 3 5 6 5  H a r b o r  B l v d
 C o s t a  M e s a ,  C a l i
 9 2 6 2 6
0 7 1 4 - 9 6 6 - 3 4 0 0
- L o c a t e d  i n  O r a n g
1 A c c t  0 9 1 5 8 4
0 A c m e  D r y  W a l l ,  I
 1 5 8 3 2  M a i n  S t .
 A n y w h e r e ,  U S A
 9 9 9 9 9
0 9 9 9 - 8 5 3 - 1 2 3 4
- L o c a t e d  i n  S a n  D
1 A c c t  0 9 1 5 8 5
0 H a w k  W o o d w o r k i n g
 2 2 3  1 5 t h  A v e  N E
 N o r t h w e s t ,  U S A
 9 9 9 9 9
0 9 9 9 - 5 5 5 - 1 2 2 3 4
- L o c a t e d  i n  K i n g
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About Channel Control Files

To use channel control characters to format your data, you must 
specify a channel control file that contains a list of the characters in the 
first column of your data and describes the type of formatting they do. 
You must know the name of this channel control file and the channel 
control characters and their definitions. If you do not have this informa-
tion, please see your system administrator.

You can use either the default channel control file provided with the 
COLD software (FN_DEFAULT), or you can create your own channel 
control file that includes the channel control characters contained in 
your data. Channel control files are stored in /fnsw/local/cold/channel 
on UNIX-based systems, and in \fnsw_loc\cold\channel on Windows 
Server systems.

COLD provides for a maximum of 255 channel control characters per 
channel control file.
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Format Data Using Channel Control Characters

The following table explains the format attributes that you can apply to 
data by using channel control characters. 

Function Description

Line Spacing
You can specify the placement of a line of data on the page relative to the 
previous data. This involves inserting blank lines before the specified line of 
output. 

Vertical Tabs

This tab places the output on a specified line on the page. The field accepts 
values through 999. Do not enter more than the actual number of lines per 
page. 

Note:You can define a channel control character with either spacing or ver-
tical tabbing instructions, but not both.

Pagination

This character specifies the beginning of a new page. If you use the default 
channel control file, the program begins a new page when encountering a “1” 
(one) in the first column. Any values in the Spacing or Vertical Tab fields ap-
ply to the new page. 

Ignore Lines

The default channel control file lists both “&” and “+” as ignore-line charac-
ters. When the program encounters the ignore-line character, the entire line 
is skipped and does not increment the line count. 

If you use a channel control character to ignore a line, COLD cannot extract 
index information or other data from it. To omit lines from committal but still 
extract index information or other data, see “Page Filter” on page 106. 
For more information on the difference between these two ways of removing 
data, see “COLD Formatting During Data Processing” on 
page 173. 
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The Default Channel Control File

The default channel control file, FN_DEFAULT, contains standard 
channel control characters that might be in use at your installation. The 
FN_DEFAULT file contains the following character definitions:   

Note COLD creates the FN_DEFAULT channel control file when the COLD 
Main Menu is invoked. 

You cannot edit the default channel control file. You can, however, save 
and rename the default channel control file, and then edit the resulting 
file.

The following illustration shows how raw data might display and print 
using the default channel control file.

Character Definition

blank Single-spaced line.

0
Double-spaced line. (Counts as two lines: the text line plus 
one blank line.)

–
Triple-spaced line. (Counts as three lines: the text line plus 
two blank lines.)

1
First character of a new page. This character starts a new 
page even if the character occurs before the expected end 
of a page.

& Ignored line. (Line counter not incremented.) 

+ Ignored line. (Line counter not incremented.)



Preparing for an Import Job

Define Channel Control File

November 2008 COLD Handbook, Release 4.1.2 47

Note If you are converting from COLD 1, you must use the FN_DEFAULT 
Channel Control file. The channel control characters that it contains 
are the only ones that were supported in COLD 1.

Raw Data Formatted Data

Acct 091585

Hawk Woodworking Co.
223 15th Ave NE
Northwest, USA
99999

999-555-12234

Located in King County

Acct 091584

Acme Dry Wall, Inc.
15832 Main St.
Anywhere, USA
99999

999-853-1234

Located in San Dimas

Acct 091583

FileNET Corp.
3565 Harbor Blvd
Costa Mesa, California
92626

714-966-3400

Located in Orange County

1 A c c t  0 9 1 5 8 3
0 F i l e N E T  C o r p .
 3 5 6 5  H a r b o r  B l v d
 C o s t a  M e s a ,  C a l i
 9 2 6 2 6
0 7 1 4 - 9 6 6 - 3 4 0 0
- L o c a t e d  i n  O r a n g
1 A c c t  0 9 1 5 8 4
0 A c m e  D r y  W a l l ,  I
 1 5 8 3 2  M a i n  S t .
 A n y w h e r e ,  U S A
 9 9 9 9 9
0 9 9 9 - 8 5 3 - 1 2 3 4
- L o c a t e d  i n  S a n  D
1 A c c t  0 9 1 5 8 5
0 H a w k  W o o d w o r k i n g
 2 2 3  1 5 t h  A v e  N E
 N o r t h w e s t ,  U S A
 9 9 9 9 9
0 9 9 9 - 5 5 5 - 1 2 2 3 4
- L o c a t e d  i n  K i n g
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Create a Custom Channel Control File

If the existing channel control files are not suitable for the data, you can 
create your own channel control file based on the FN_DEFAULT file or 
another channel control file. The following procedures explain how: 

1 From the COLD Main Menu, select Define Channel Control File. This 
displays the Define Channel Control File window. 

2 To display a list of available channel control files, click on the List 
button. COLD displays a list of channel control files available on your 
system.

3 Depending on the channel control characters in your data, select a 
channel control file that suits your needs. 

4 From the File menu, select the Save As option. COLD displays the 
Save As dialog box.

5 Enter the name of your choice. Use standard file-naming conventions. 
The maximum field length is 14 characters. 

6 Click OK to save the name. COLD displays a dialog box with a mes-
sage informing you that the file “was successfully saved.” 
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7 Click OK. 

To make additions or changes to the new file, including adding a 
description, follow the steps in the “Edit a Channel Control File” on 
page 49.

Edit a Channel Control File

A channel control file lists the channel control characters and specifies 
the formatting that those characters indicate. When changing a file, 
you might need to add, modify, or delete channel control characters. 
You cannot modify the default channel control file, FN_DEFAULT. 

Tip When running Windows 95, some channel control characters are 
hidden from Microsoft® Notepad and other editors. If you want to see 
those hidden characters, try opening the channel control file in Binary 
mode using the MS-DOS Editor. To start the editor, enter EDIT at the 
Run Command Line.

To edit an existing channel control file:

1 From COLD’s Main Menu, click on the Define Channel Control File but-
ton to display the Define Channel Control File window. 
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2 Click the List button to display the Selection Box.

3 Select the name of the desired file or enter the name of the file.

4 To add characters to the channel control file, click on the Add button 
and go to page 51. 

To change characters in the channel control file, click on the Modify 
button and go to page 53. 
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To delete characters from the channel control file, click on the Delete 
button and go to page 54. 

To add a character to the channel control file:

1 In the Define Channel Control File window, click the Add button to dis-
play the Add/Modify Channel Control window. 

2 Click the down arrow to the right of the Channel Control field to display 
a drop-down menu containing up to 255 channel control characters.

The four positions on the left side of the list show the hexadecimal 
value of each character. The remaining text to the right describes each 
character.
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3 Scroll down the list until you find the hexadecimal value and descrip-
tion that you want to use; then click on it to select it. 

4 Enter values in the four remaining fields to specify the type of format-
ting you want COLD to apply every time it encounters the selected 
character in the first position of a line. The following table explains what 
happens when you enter information in one of these fields.

Note Spacing and vertical tabbing are mutually exclusive formatting options. 
You cannot specify both for the same character. 

Field Action

Channel control
This field displays the hexadecimal value and description 
for the selected channel control character.

Spacing

Enter a value for the desired line spacing that the selected 
channel control character is to implement: 

1 for single spacing

2 for double spacing, etc. 

The Spacing field accepts as many as 999 blank lines. 

Vertical tab

Enter the line number on which COLD is to place the data 
when encountering the selected channel control charac-
ter. The field accepts values through 999. Do not enter a 
value greater than the actual number of lines per page. 

Paging
Enter the channel control character that signals COLD to 
begin a new page. The character that you enter must 
match the hexadecimal value and description.

Ignore
Enter the channel control character that signals COLD to 
ignore a line. The character that you enter must match the 
hexadecimal value and description.
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5 After you specify the formatting for the selected character, click the OK 
button. This saves the changes to the file.

When you finish adding channel control characters, click the Cancel 
button to return to the Define Channel Control File window. Your 
defined character and its hexadecimal value display in the Character 
column.

6 In the Define Channel Control File window, you can choose to either:

• Continue to edit channel control characters in the selected file, or

• Return to the COLD Main Menu by selecting Save and then 
selecting Exit from the File menu.

To modify a channel control character:

1 In the Define Channel Control File window, select the channel control 
character that you want to change.

2 Click the Modify button to display the Add/Modify Channel Control win-
dow.

3 Change any values in this window as described in “To add a charac-
ter to the channel control file:” on page 51.

4 Click the OK button. COLD returns you to the Define Channel Control 
File window and displays your changes.

5 In the Define Channel Control File window, you can choose to either:

• Continue to edit channel control characters in the selected file, or

• Return to the COLD Main Menu by selecting Save and then 
selecting Exit from the File menu.
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To delete a character from the channel control file:

1 In the Define Channel Control File window, select the channel control 
character that you want to delete.

2 Click the Delete button. COLD displays a window that asks for confir-
mation. For example:

Channel control character ‘[+]’ will be removed. Are you sure?

3 To confirm your deletion, click the Yes button. COLD returns you to the 
Define Channel Control File window. Your deletion is in effect.

4 You can choose to either:

• Continue to edit channel control characters in the selected file, or 

• Return to the COLD Main Menu by selecting Save and then 
selecting Exit from the File menu. 
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Define Report Format
In addition to the Channel Control files, COLD gets further formatting 
instructions for the raw data by accessing one or more Report Format 
files. The Report Format includes rules for indexing, displaying, format-
ting, and printing documents. You can specify up to 200 Report For-
mats for any import job file.   

Before You Begin

Before you begin the procedures in this section, collect the data listed 
in “How to Begin” on page 31. You might also want to read the sec-
tion, “COLD Formatting During Data Processing” on page 173.

Tip Before defining the Report Format, you might want to print a few pages 
of the data from your mainframe; then create a grid to find the location 
of the various data that you plan to use (lines and columns). This is 
useful when filling in the Report Format fields. In the following 
example, a grid overlaying the data represents columns and lines. 
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You can also use the information in “Preview Seek Methods & String 
Location” on page 139 to locate specific data.

The following sections describe how to complete the Report Format. 
These sections usually begin with a brief introduction and an illustra-
tion showing the items on the screen pertinent to the procedures. 
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Creating a Report Format is a relatively long procedure. Broadly, the 
steps are:

• Specify a name for the Report Format file.

• Define a value found in the data that uniquely identifies the Report 
Format file to use on that page.

• Define the various attributes to apply to the document, such as 
fixed- or variable-length document, how many lines per page, etc.

• Define how the document is to be committed: table of contents, 
page compression, document class, etc.

• Identify the source of the indexing information.

• Specify how many tables of contents to create, whether to use mul-
tiple background templates, and to filter pages or lines. 

• Specify fonts and margins.
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The Define Report Format Window

From the COLD Main Menu, select Define Report Format to display 
the Define Report Format window where you specify the Report 
Format parameters. 
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Specify the Report Format Name

The Report Format Name field identifies the name of the file that con-
tains formatting instructions for the COLD data. You can either select 
an already-existing Report Format or you can enter a new name and 
begin defining its attributes. The Report Format files are stored in the 
directory /fnsw/local/cold/formats.

The items involved in this process are: 
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Field or Button Description

Report format 
name

This is the name of the file that contains your formatting 
instructions. 

List button
Click this button to display a list of the existing Report 
Format names. New names are added or changed here.

Description
This is the Report Format description. You can enter 
any description that is meaningful to you.
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To define a Report Format name:

1 To display the Selection Box containing a list of current COLD report 
files, click the List button. 

2 Select an existing Report Format file name. To create a new Report 
Format, enter a new Report Format file name (use standard file nam-
ing conventions). The maximum Report format name field length is 14 
characters. 

3 Click the OK button.

COLD returns you to the Define Report Format window.

4 In the Description field, enter any meaningful text describing the Re-
port Format. The maximum Description field length is 30 characters.

Define the Report ID Value

The Report ID is a constant value that COLD finds on the first page of 
your document to determine which Report Format applies to that docu-
ment. You define the line, column, and character string that COLD 
must find. The Report ID (character string) literal must be on the first 
page of each document. You can define an appropriate report ID literal; 
or you can use the paging channel control character as a report ID. 
See “Format Data Using Channel Control Characters” on page 45 
for more information about channel control characters. 
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The items involved in this process are:

For more details on defining Report ID values, see “Define Document 
Attributes” on page 62.

Note COLD looks for the report ID in the unformatted (preprocessed) data. 
This means that no channel control processing has been done. You 
should be aware of how channel control character formatting can affect 
your final data output. Please see “COLD Formatting During Data 
Processing” on page 173.

Field Description

Line The line number on which COLD finds the Report ID literal.

Column The column number in which COLD finds the Report ID literal.

Literal
The constant value (the Report ID literal) that COLD finds on the 
first page of your document to determine which Report Format ap-
plies to that document.

If you use the paging channel control character as the Report ID 
literal, COLD locates the channel control character on the first 
page as follows:

Variable-Length Documents
Finds the start-of-document indicator(s).

Fixed-Length Documents
Reads the pages-per-document value from the Report For-
mat file.

Length
The length of the literal. COLD automatically determines the length 
when you enter the characters in the Literal field.
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To specify the report ID literal:

1 In the Line field, enter the line number where COLD can find the report 
ID literal.

2 In the Column field, enter the column number where the report ID lit-
eral begins.

3 In the Literal field, enter the report ID value (from your session check-
list). The maximum length for the Literal field is 30 characters. COLD 
automatically determines the length when you enter the characters in 
the Literal field.

Define Document Attributes 

Use the Document Attributes section to indicate whether the docu-
ment’s page count is fixed-length or a variable-length. Also, here is 
where you define the dimensions of the page. 
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Fixed-Length Documents 

If you select the Fixed Page button to indicate that the number of 
pages is to be fixed, each document will have the same maximum 
number of pages. A fixed-length document can have from one to a 
maximum of 1,000 pages. Fixed-length documents can have from one 
to three tables of contents. So, a document with seven images and 
three tables of contents would contain ten pages. 

Tip To save time, we suggest that you process similar pages (such as 
invoices) as one long document rather than a series of one-page docu-
ments. A 100-page document processes about four times faster than 
100 one-page documents.

To define a fixed-length document:

1 In the Document Attributes section, click the Fixed page button. 

2 In the Pages per Document field, enter the number of pages in a 
document.   

3 Please skip to “To define page dimensions:” on page 70. (The fol-
lowing paragraphs discuss variable-length documents.)

Variable-Length Documents 

If your data pages vary in length, such as bank account activity, you 
must specify when to start a new document. A start-of-document indi-
cator specifies when to start a new document. If the data varies to the 
point that one start-of-document indicator is insufficient, you can define 
variable-length documents with up to three start-of-document 
indicators. 
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For a variable-length document, the items involved are: 

For for each start-of-document indicator, you define the indicator’s 
location by line, column, and length. For the second and third start-of-
document indicators, you also define the Boolean operators, and or or. 

Field or Button Description

Select the Variable Page button to indicate that the number of pages per doc-
ument vary. That is, one document could have 36 pages and another could 
have 800. The criteria for when to start a new document are determined by 
the remaining items in this group, including the page dimension fields.

Start of Document #1
#2 and #3

A value that COLD compares with values in the same place on every page 
(defined by line, column, and length). When COLD finds the start-of-docu-
ment indicator value in the specified location, COLD starts a new document. 

You can specify up to three start-of-document indicators with Boolean oper-
ators to establish their logical relationships. The start-of-document option 
compares the current page to the previously-processed page, as opposed to 
comparing with the first page in the document.

Line
Defines the line where COLD looks for the value to determine where a new 
document begins.

Column
Defines the column where COLD looks for the value to determine where a 
new document begins.

Length

The length tells COLD how many characters are in the start-of-document in-
dicator. After the length count, COLD starts looking for a new start-of-docu-
ment indicator. The indicator is limited to a maximum of 150 characters. An 
indicator can be as many characters as the specified line, minus 1. Column 
1 is always reserved for the channel control character.

Boolean

COLD activates the Boolean field at the end of the Start of Document #1 
fields when you select the Start of Document #2 button. When you select the 
Start of Document #3 button COLD activates the Boolean field at the end of 
the Start of Document #2 fields. You can use the Boolean operators, and and 
or, to further clarify where COLD is to start a new document.
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For multiple start-of-document indicators, enter the start-of-document 
indicators’ values from the top down (indicator #1, then #2, then #3). 
COLD reads the start-of-document indicator field values in the order 
indicated by the arrow: 

Start-of-document indicators don’t have to be consecutive in the data. 
For example, you can achieve other combinations by specifying that 
the start-of-document indicator occurring first in the data is the third 
start-of-document indicator in the Report Format, as in the following 
illustration:

Using this information, COLD searches for the specified indicators, 
compares them, and calculates when to start a new document. 
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If the start-of-document indicator does not change in 1,000 pages, 
COLD automatically starts a new document, using the same attributes 
as for the first document.

Variable-length documents with 
a single start-of-document indicator

The following example uses the Acct number as a start-of-document 
indicator. The Acct number begins in line 1, column 11, and is four 
characters long. COLD starts a new search in column 1, line 2. In this 
illustration, COLD finds a new start-of-document indicator after two 
more pages.
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Variable-length documents with 
multiple start-of-document indicators

The three start-of-document indicators highlighted in the illustration 
below, Acct number (1ACT), the route (2RTE), and Cost Center 
number (3CCN), give an example of how you might use three start-of-
document indicators.
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Using the three indicators and the various Boolean operator combina-
tions produces the following:   

To define a variable-length document:

Use the following illustration as an example for the procedures:

1 In the Document Attributes section, click the Variable page button.

2 In the Start of Document #1 Line field, enter the line number of the 
start-of-document indicator. (On the illustration, line six (6).)

Field 1 Oper. Field 2 Oper. Field 3 Starts a new document only when…

1ACT or 2RTE either field changes.

1ACT and 2RTE both fields change.

1ACT or 2RTE or 3CCN any of the three fields changes.

1ACT and 2RTE and 3CCN all three fields change. 

(1ACT and 2RTE) or 3CCN both fields 1 and 2 change, or when field 3 changes.

(1ACT or 2RTE) and 3CCN either field 1 or field 2 changes, and field 3 changes too.
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3 In the Start of Document #1 Column field, enter the column number 
where the start-of-document indicator begins. (On the illustration, col-
umn six (6).)

4 In the Start of Document #1 Length field, enter the indicator length. 
(On the illustration, 7 including the hyphen.) If you are defining only 
one start-of-document indicator, skip to “To define page dimen-
sions:” on page 70.

5 For the second start-of-document indicator, click the Start of Document 
#2 button.

6 Click the drop-down list arrow in the same row as the Start of Docu-
ment #1. Select a Boolean operator, and or or. 

7 Repeat steps 2, 3, and 4 to enter the line, column, and length informa-
tion for Start of Document #2. If you are defining only two start-of-doc-
ument indicators, skip to “To define page dimensions:” on page 70.

8 For the third start-of-document indicator, click the Start of Document 
#3 button.

9 Click the drop-down list arrow in the same row as the Start of Docu-
ment #2. Select a Boolean operator, and or or. 

10 Repeat steps 2, 3, and 4 to enter the line, column, and length informa-
tion for Start of Document #3. 
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Page Dimensions

Page dimension information is used with both fixed-length and vari-
able-length documents to define the amount of text that will fit on a 
page. Page dimensions are described by lines per page, starting 
output column, and print text width.

The items for describing page dimensions are: 

To define page dimensions:

1 In the Lines Per Page field, enter the maximum number of lines to print 
on one page. 

A page can contain from one to a maximum of 150 lines. Lines that are 
partially filtered and those that are formatted as double- and triple-
spaced count toward this maximum.

If the lines are too long to display in the window when you view COLD 
documents after committal, you can scroll the text or enlarge the 
window so that all lines display.

Field or Button Description

Lines per page Specifies the number of lines per page.

Starting output column
The first column of data to save to optical disk. Be-
cause the first column is reserved for the channel 
control character, the default is column 2.

Print text width
The number of characters to print beginning with the 
starting output column.
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2 In the Starting Output Column field, enter the column number in which 
to begin printing. This applies to all lines of data that will be committed 
to optical disk. The default is 2, since the first character in a line is con-
sidered a channel control character.

3 In the Print Text Width field, enter the number of columns to print.

COLD permits a maximum of 256 characters per line. By entering a 
value of less that 256 in the Print Text Width field, you can print part of 
a line. To print part of a line, enter the number of characters that you 
want to print, beginning with the starting output column. Column 1 is 
reserved for the channel control character. So, if you enter 50 in the 
Print Text Width field, and you have 2 defined in the Starting Output 
Column field, columns 2 through 51 will print. 

Define Committal Attributes

The Committal Attributes information controls how the document is 
committed. The following paragraphs describe the Committal 
Attributes fields and the information that you can specify. 
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The items involved in this process are:  

The following pages explain these fields and buttons in more detail.

Enable Table of Contents 

To generate a table of contents, click Enable Table of Contents button 
on the Define Report Format dialog box. This activates the Table of 
Contents option on the Edit menu. You must also specify the location 
of the table of contents identifier. 

See “To generate a table of contents:” on page 77 for the actual 
procedures.

Field or Button Description

Enable Table of 
Contents

Selecting this button specifies that COLD is to create a table of contents. You 
must specify more information about the table of contents by using the Table 
of Contents option from the File menu, which defines the appearance and 
function of the table of contents in the document.

Enable Page 
Compression

Selecting this button specifies that page compression be used. This button 
turns text compression on or off in the COLD document. Even with page 
compression turned off, COLD compresses trailing blanks and blank lines by 
default.

Document Class
A document class is required for every Report Format. Click the down arrow 
next to this field to display a list of the available document classes. Select a 
document class to use for the Report Format.

Indexes

Selecting this button displays the indexes associated with the document 
class displayed in the Document Class field. Click the Indexes button to se-
lect an index to use with the document class and to define indexing 
information.
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COLD builds the table of contents after processing the last page of a 
document. When you retrieve the document, COLD displays the table 
of contents first. From one to three tables of contents can be included 
at the beginning of a document. Each table of contents page counts as 
one page in the document. 

COLD arranges the table of contents page(s) based on the number of 
its entries. COLD formats the entries into four columns, making it pos-
sible to display all the entries without scrolling. The following table 
explains the logic that COLD uses to format the table of contents. 

Table of contents identifier

If you select Enable Table of Contents, you must specify the location of 
the table of contents identifier. The table of contents identifier is a 
string of characters in the same place on each page.

When you generate a table of contents for a document consisting of 
multiple pages, COLD looks for this string of characters. Every time the 
string of characters changes, COLD adds the new characters—and 
associated page number—to the table of contents. This string, the 
table of contents Identifier, can be up to 30 characters long.

Number of Entries Number of Rows

Less than 300 75

300 or more but less than 599 150

More than 599 250
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A COLD document can have a maximum of 1,000 pages and can have 
a maximum of three tables of contents. Each table of contents reduces 
the number of data pages in the COLD document. So, with one table of 
contents, a COLD document has a maximum of 999 data pages. With 
two tables of contents, the maximum is 998 pages. And, with three 
tables of contents, the 997 is the maximum number of pages.

Table of contents keys

For the first table of contents, COLD lists the table of contents keys and 
page numbers in the order in which they appear in the data. For COLD 
to list the table of contents in alphabetic or numeric order, the data 
must be sorted before it is imported or written to tape. You can use the 
first and last table of contents keys as index values if the data is sorted 
on the first TOC indicator only. For example, if your first TOC indicator 
on a page is a zip code, you can use the first and last zip code as a 
range of zip codes. 

You can specify that COLD create up to three tables of contents per 
COLD document. Each table of contents can be based on a different 
key value. For example, table number one might list last names, table 
number two might list job titles, and table number three might list pay-
roll numbers. 
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Table of contents layout

The index key determines the entries that will be on each table of con-
tents page. The order of entries on the first table of contents is based 
on the order of entries within the document, in other words, page order. 
Second and third table of contents pages will contain entries based on 
the sorted order of their associated key values. The first key value on a 
page is the only one used for indexing. 

For example, you specify the table of contents index keys as:

Last name (first key)

Job title (second key)

Social security number (third key)

The document contains this information:

Last Name Job Title SSN Page

Adams Product Engineer 321549987 4

Anderson Manager, CS 123456789 5

Ball Manager, QA 765444437 6

Smith Programmer 125678987 7
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The first table of contents, based on Last Name, could look like the fol-
lowing table. This document has a second and third table of contents, 
so the page numbers start at page 4. The first table of contents is 
based on the order of the entries within the document. 

The second table of contents (sorted on job title) might look like this:

The third table of contents (sorted on social security number) might 
look like this:

Adams 4

Anderson 5

Ball 6

Smith 7

Manager, CS 5

Manager, QA 6

Product Engineer 4

Programmer 7

123456789 5

125678987 7

321549987 4

765444437 6   
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To generate a table of contents:

1 In the Committal Attributes section, click the Enable Table of Contents 
button. This activates the Table of Contents command on the Edit 
menu. 

2 From the Edit menu, select Table of Contents to display the Table of 
Contents dialog box. 

3 In the Table of Contents #1 Line field, enter the line number where 
COLD can find the table of contents identifier.

4 In the Table of Contents #1 Column field, enter the column number 
where the table of contents identifier begins.
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5 In the Table of Contents #1 Length field, enter the length (1 to 30) of 
the table of contents identifier.

If you want only one table of contents, proceed to the next step. For 
second and third tables of contents, repeat steps 2, 3, and 4 for the 
Table of Contents #2 and #3 Line, Column, and Length fields. 

6 To specify a background template for the table of contents pages, click 
the down arrow next to the Template field. COLD displays a list of tem-
plate files available on your system. 

7 Click on the desired template name to select it.

8 To define the font, typeface style, characters per inch, lines per inch, 
and top and left margin offsets for the text that uses this template, click 
the Page Setup button. If you do not select Page Setup, COLD uses 
default settings for these parameters. The default settings are based 
on how the raw data is formatted.

For details on Page Setup settings and information on how COLD 
applies the default settings, see “The Page Setup Dialog Box” on 
page 121.

9 Click the OK button to exit from the Page Setup window and return to 
the Table of Contents dialog box.

10 To accept the Table of Contents values that you have entered and exit 
from the window, click the OK button. COLD returns you to the main 
Define Report Format window. 
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Enable Page Compression

Even when page compression is off, COLD still compresses trailing 
blanks and blank lines. If you turn page compression on, COLD com-
presses the text as well.

With compression turned off, you can expect a compression ratio of 
approximately 2:1 (raw data versus processed data). With compres-
sion turned on, you might get compression ratios as high as 4:1. These 
ratios are estimates and are normally possible only with longer 
documents. 

To enable/disable page compression: 

Click the Enable Page Compression button. The center of the button 
depresses to indicate that compression is on. 

Click the button again to turn it off. The center of the button pops up to 
indicate that compression is off.

Designate a Document Class

A Report Format must have a document class, and you can only 
choose document classes that are available at the time that you are 
creating the Report Format. Each Report Format can use a different 
document class, or all of them can use the same one.
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Scanned documents and COLD documents can use the same docu-
ment class. To distinguish COLD documents from scanned documents 
in the same document class when looking at a Query Match Report, 
look at the document type. COLD documents committed without a 
background template are type TEXT. COLD documents committed 
with a background template are type MIXED. Keep in mind, however, 
that the types TEXT and MIXED are also used for documents other 
than COLD documents. For details on document types, see the Image 
Services System Administrator’s Handbook. To download IBM FileNet 
documentation from the IBM support page, see “Accessing IBM 
FileNet Documentation” on page 16.

To specify a document class:

In the Define Report Format window, click the down arrow next to the 
Document Class field. Scroll through this list until you find the desired 
document class name. Click on the document class name to select it.

If you need to modify a document class’s index or add an index to a 
document class, you must do so via Image Services Database Mainte-
nance. (See the Image Services System Administrator’s Handbook for 
more information. To download IBM FileNet documentation from the 
IBM support page, see “Accessing IBM FileNet Documentation” on 
page 16.) In COLD, you can modify the index source, the date mask, 
the index value if it is a constant, and its location in the document, if it is 
a variable.

Document Class Index Names

After selecting a document class name, specify the indexes in that doc-
ument class to associate with your COLD data.
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Click the Indexes button to open the Document Class Information 
dialog box. From this dialog box you can select from a list of index 
names that belong to the selected document class. Use the Name, 
Type, and Source columns as a guide to your selection.

COLD permits a maximum of 224 indexes per Report Format. If you 
select a document class with more than 224 indexes, the program 
ignores any above 224.
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The index-related fields in the Document Class Information window are 
Index Name, Type, and Source. 

The table below shows the relationship between the index type and the 
source values.

Field Name Description

Index Name
Index Name is the name given to the index when it was created in the IS Da-
tabase Maintenance application. You cannot modify the Index Name.

Type

Type is assigned in the IS Database Maintenance application. The index field 
types that COLD supports are: string, numeric, menu, and date. For details 
on field types, please refer to the System Administrator’s Handbook. To 
download IBM FileNet documentation from the IBM support page, see 
“Accessing IBM FileNet Documentation” on page 16.

Source
Source is where or how the index value is found in the document. Source can 
be used for all index types: string, numeric, date, and menu. Source can be: 
document, constant, keyword, or TOC.

Index Type
 Default

Source Value  Other Source Values

String No Value

Constant
Document
Keyword
TOC (if specified in Report Definition)

Numeric No Value
Constant
Document
Keyword
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Menu No Value
Constant
Document
Keyword

Date Run Date
Constant
Document
Keyword

Index Type
 Default

Source Value  Other Source Values



Preparing for an Import Job

Define Report Format

November 2008 COLD Handbook, Release 4.1.2 84

Note Valid menu items are defined in Database Maintenance. 

If the value—based on “document” or “keyword”—that COLD assigns 
to a Menu index type is invalid, COLD automatically defaults to the first 
valid Menu item. COLD then generates a warning in the Log file.

If the value that COLD assigns to a Numeric or Date index type is 
invalid, and an override date mask is not defined in the Indexing Infor-
mation window (Date Mask field), COLD accepts the value but issues a 
warning in the Log file.

Specify Indexing Information

When you select an index name in the Document Class Information 
dialog box, the Indexing Information dialog box appears as shown on 
the following page. 

It might be helpful to refer to this screen as you continue through this 
section.
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The following pages provide procedures to describe the specific 
indexing information for each source value: constant (page 87), docu-
ment (page 90), run date (page 92), no value (page 93), 1st & last 
TOC page (page 94), and keyword (page 95).

The following tables describe the index types that you can associate 
with the index value source: 

Source Index Type Source Index Type

Constant

String
Numeric
Menu
Date

No Value
String
Numeric
Menu

Document

String
Numeric
Menu
Date

Run Date Date

Keyword

String
Numeric
Menu
Date

1st TOC and 
Last TOC 
Page

Only available 
when Report Defi-
nition TOC is on.
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To specify indexing information—Source: Constant:

Use Constant with index types String, Numeric, Menu, and Date. A 
constant value is the same value throughout the document. 

1 In the Document Class Information dialog box, click an index name. 

2 Click the Modify button to display the Indexing Information dialog box, 
which holds index information, source parameters, and the index iden-
tification method.

3 Choose the source of the index value by clicking the down arrow next 
to the Source field and selecting Constant.

When you select Constant in the Source field, COLD enables the Con-
stant/Date Mask field.

4 For the index type that you want to use, perform the actions described 
in the corresponding bulleted item below. Enter the values in the Con-
stant/Date Mask Field.

• String—Enter the value. The maximum length is defined in IS 
Database Maintenance. Only 10 characters display in this window. 
The Query Match Report displays all the characters after 
committal.

• Numeric—Enter the value. The value can only be numeric. If a 
mask is defined in IS Database Maintenance, the value must con-
form to the mask. The maximum length is defined in IS Database 
Maintenance. Only 10 characters display in this window. The 
Query Match Report displays all the characters after committal.

• Menu—Click the down arrow next to the Menu Items field to select 
from a list of menu item values.
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• Date—Enter the date. If a mask is defined in IS Database Mainte-
nance, the value must conform to the mask. See the following para-
graphs for more information on dates. For information on the date 
masks residing on the FileNet system, see “FileNet System Date 
Masks” on page 195. 

If you use a two-digit date mask, COLD displays the following 
dialog box when you enter the date.

Y2K

In this dialog box, you can choose to always pre-append either 19 
or 20 to the two-digit year, or you can enter a threshold year where 
COLD pre-appends 19 to the year following the threshold year and 
all intervening years until 2000.
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If you select Threshold Year, you can designate which year you 
want COLD to start applying the 19. For example, you might want 
all two-digit years pre-appended with 19 beginning with the year 
that your company started. If your company started in 1968, you 
would use 67 as the threshold year. COLD then pre-appends 19 to 
all two-digit years from 68 through 99 inclusive, and pre-appends 
all two-digit years from 00 through 67 with 20.

The following table gives examples of how the threshold year logic 
works:

5 Click the OK button. COLD returns you to the Document Class Infor-
mation window and displays your changes in the Source column.

6 To save the indexing information, click on the OK button. This return 
you to the Define Report Format window.

7 In the Define Report Format window, select Save from the File menu.

Threshold Year Pre-append with 19 Pre-append with 20

16 17 through 99 00 through 16

67 68 through 99 00 through 67

83 84 through 99 00 through 83
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To specify indexing information—Source: Document:

Use Document with index types String, Numeric, Menu, and Date. 

1 Click an index name in the Document Class Information dialog box. 

2 Click the Modify button to display the Indexing Information dialog box, 
which holds index information, source parameters, and the index iden-
tification method.

3 Choose the source of the index value by clicking the down arrow next 
to the Source field and selecting Document.

When you select Document as the source, COLD enables the Con-
stant/Date Mask, Page, Line, Column, and ID Methods (Length, Token 
Concatenation, Filter Mask) fields. 

The values that you enter in these fields indicate where COLD is to find 
the index value in the document. The data items found at these loca-
tions must conform to the index field type.

4 To use the default mask defined in IS Database Maintenance, leave 
the field blank and tab to the next field. To override the default mask, 
enter the mask you want to use. For information on using a two-digit 
year, see page 88.

5 Enter the document Page number where COLD can find the index 
value. This is a required value.

6 Enter the Line number where COLD can find the index value. 

7 Enter the Column number where COLD can find the index value.

8 Select either the Bytes or Characters radio button.
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a For single-byte (NLS) language support, select Bytes (default).

b For multi-byte (NLS) support, for languages such as Japanese, you 
can select Bytes or Characters.

Note Refer to, “Multi-byte Character Support” on page 27 to see the nec-
essary requirements for multi-byte character support.

9 In the Index Identification Method section of the Indexing Information 
dialog box, select one of the following methods for identifying the index 
value. See “Specify Index Identification Method” on page 97 for 
more information.

• Length—select the length button, enter the length of the index 
value, and select either the Bytes or Characters radio button. 

- For single-byte (NLS) language support, select Bytes (default).

- For multi-byte (NLS) support, for languages such as Japanese, 
you can select Bytes or Characters.

• Token Concatenation—select the Token Concatenation button 
and enter the Token Count and Token Separator for the index 
value. For details, see “To obtain index values by token concat-
enation:” on page 99.

• Filter Mask—select the Filter Mask button and enter the Filter 
Mask for the index value. For details, see “To obtain index values 
by filter mask:” on page 100.

10 Click the OK button. COLD returns you to the Document Class Infor-
mation window and displays your changes in the Source column. 
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11 To save the indexing information, click on the OK button. This returns 
you to the Define Report Format window.

12 In the Define Report Format window, select Save from the File menu.

To specify indexing information—Source: Run Date:

Use Run Date with index type Date only. Using Run Date causes 
COLD to use the system date on the day you run the COLD import job. 
COLD formats the date as it is specified in IS Database Maintenance. 

1 Click an index name in the Document Class Information dialog box. 

2 Click the Modify button to display the Indexing Information dialog box, 
which holds index information, source parameters, and the index iden-
tification method.

3 Choose the source of the index value by clicking the down arrow next 
to the Source field and selecting Run Date.

When you select Run Date in the Source field, COLD displays the Con-
stant/Date Mask field. 

4 To use the default mask defined in Database Maintenance, leave the 
field blank and tab to the next field. To override the default mask, enter 
the date you want to use. For information on using a 2-digit year, see 
page 88.

To determine which date mask to use, you can either run the User 
Index Report from IS Database Maintenance or enter a date mask that 
matches the data. See the Image Services System Administrator’s 
Handbook for more detailed information. To download IBM FileNet 
documentation from the IBM support page, see “Accessing IBM 
FileNet Documentation” on page 16.
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5 Click the OK button. This returns you to the Document Class Informa-
tion window and displays your changes in the Source column.

6 To save the indexing information, click on the OK button. This returns 
you to the Define Report Format window.

7 In the Define Report Format window, select Save from the File menu.

To specify indexing information—Source: No Value:

Use No Value with index types String, Numeric, and Menu. No value 
indicates that an index is not used in your COLD data. Using No Value 
causes COLD to ignore the index. No Value cannot be used with index 
type Date. 

1 Click an index name in the Document Class Information dialog box. 

2 Click the Modify button to display the Indexing Information dialog box, 
which holds index information, source parameters, and the index iden-
tification method.

3 Choose the source of the index value by clicking the down arrow next 
to the Source field and selecting No Value.

4 To save the indexing information, click on the OK button. This returns 
you to the Define Report Format window.

5 In the Define Report Format window, select Save from the File menu.



Preparing for an Import Job

Define Report Format

November 2008 COLD Handbook, Release 4.1.2 94

To specify indexing information—
Source: 1st TOC Page & Last TOC Page:

The 1st TOC page and Last TOC page option is available only if the 
index field is a string type, and if you selected the Yes button for Enable 
Table of Contents. When the table of contents entries consist of a 
sequence of values in ascending or descending order, the first and last 
values are useful for document retrieval. 

Note The 1st TOC page and Last TOC page option refers only to the first 
table of contents parameter entered. Second and third tables of con-
tents cannot be used. 

1 Click an index name in the Document Class Information dialog box. 

2 Click the Modify button to display the Indexing Information dialog box, 
which holds index information, source parameters, and the index iden-
tification method.

3 Choose the source of the index value, by clicking the down arrow next 
to the Source field and selecting 1st TOC Page and Last TOC Page.

4 Click on the OK button. COLD returns you to the Document Class In-
formation window and displays your changes in the Source column.

5 To save the indexing information, click on the OK button. This returns 
you to the Define Report Format window.

6 In the Define Report Format window, select Save from the File menu.
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To specify indexing information—Source: Keyword:

Use the keyword index type to capture an index value that is not in the 
same place on every page. For example, the number of invoice line 
items might vary from invoice to invoice causing the column totals to 
fall on a different line on each invoice. If the words “Invoice Total” 
always precede the index value, you could specify that COLD find 
“Invoice Total” and use the next “word” as an index value. To do this, 
you specify offset coordinates for COLD to use in finding the index 
value. For examples and explanations of offsets, see “Find Index 
Values Using Offset Coordinates” on page 101. 

To use an index value that is in the same place on every page, see “To 
specify indexing information—Source: Document:” on page 90.

Note In both the Preview and the Import functions, COLD terminates if it 
cannot find the keyword literal in a document. When termination 
occurs, COLD displays a message in the Preview or Import window, 
whichever process you are attempting. 

1 In the Document Class Information dialog box, click an index name. 

2 Click the Modify button to display the Indexing Information dialog box, 
which holds index information, source parameters, and the index iden-
tification method.

3 Choose the source of the index value, by clicking the down arrow next 
to the Source field and selecting Keyword.

When you select Keyword in the Source field, COLD displays the Lit-
eral field. The Constant/Date Mask field is replaced by the Literal field 
when Keyword is selected.
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4 In the Literal field, enter the keyword you want to find. 

5 In the Page field, enter the page number on which COLD is to find the 
keyword. 

Note If you leave the Line and Column fields blank, COLD searches the cur-
rent page for the keyword. Only leave these fields blank if the keyword 
is not in the same place on every page.

6 In the Line field, enter the line where COLD can find the keyword. This 
step is optional.

7 In the Column field, enter the column where COLD can find the 
keyword. 

8 Select the value of the Horizontal Offset.

• To specify how many words after the keyword to find the index 
value, click the right arrow in the Horizontal Offset scale. 

• To specify how many words before (minus) the keyword to find the 
index value, click the left arrow in the Horizontal Offset scale.

9 Select the value of Vertical Offset.

• To specify how many lines after the keyword to find the index 
value, click the right arrow in the Vertical Offset scale. 

• To specify how many lines before (minus) the keyword to find the 
index value, click the left arrow in the Vertical Offset scale.
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10 Enter the ID Method of the index value. See “Specify Index Identifi-
cation Method” on page 97 for more information.

• Length—select the length button and enter the length of the index 
value. 

• Token Concatenation—select the Token Concatenation button 
and enter the Token Count and Token Separator for the index 
value. For details, see “To obtain index values by token concat-
enation:” on page 99.

• Filter Mask—select the Filter Mask button and enter the Filter 
Mask for the index value. For details, see “To obtain index values 
by filter mask:” on page 100.

11 Click the OK button. This returns you to the Document Class Informa-
tion window and displays your changes in the Source column.

12 To save keyword information, click on the OK button. This returns you 
to the Define Report Format window.

13 In the Define Report Format window, select Save from the File menu.

Specify Index Identification Method

Index values can be identified by length, token concatenation, or filter 
mask. Using length as an index identification method is more limited in 
capability than the other two methods (token concatenation or filter 
mask). The length method limits you to whatever text the software finds 
within the specified length.

The token concatenation or filter mask methods allow you to manipu-
late the index value prior to storing it. 
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To obtain index values by length:

Use the Length option to find a specific, non-changing length of text. 
With the length method, you obtain index values from the document 
text using a length parameter with either keyword or document as 
index sources. 

Note You must select this option for multi-byte character support.

1 To choose length as the index identification method, select the Length 
button.

2 Enter the length of the keyword or document location to be indexed 
and select either the Bytes or Characters radio button.

- If the index source is Keyword, select Bytes (default) for single-
byte (NLS) language support.

- If the index source is Document, select either the Bytes or 
Characters radio button.

Note For multi-byte (NLS) support, for languages such as Japanese, select 
Characters.

3 Click the OK button. This returns you to the Document Class Informa-
tion window.

4 To save the index value information, click on the OK button. This re-
turns you to the Define Report Format window.

5 In the Define Report Format window, select Save from the File menu.
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To obtain index values by token concatenation:

Use Token Concatenation to find a specific number of words and strip 
the blank spaces from around them. You can also use a separator, 
which is an optional character that can be inserted between the words, 
such as a comma. Without a separator, the words will have no spaces 
or separators between them. 

With this method, you specify a set of characters, called a token count, 
to obtain an index value. Token Count is the number of words, or set of 
characters delimited by white space, that you want to use as the index 
value. You can use from one (1) to 24 words. It indicates where to find 
an index value in relation to the specified document or keyword. 

In addition, you can also specify a token separator of one character 
between each token during concatenation. This provides greater flexi-
bility in setting index values. The Token Separator can be any alphanu-
meric or punctuation character.

For example, in the following text, you use the keyword NAME with a 
horizontal offset of one word. You specify a token count of two and no 
token separator:

NAME: Smith, John

After token concatenation, the index value is SmithJohn. If you use a 
comma as a token separator, the index value after token concatenation 
is Smith,John.

1 To choose token concatenation as the index identification method, se-
lect the Token Concatenation button.

2 Enter the value for the Token Count (number of words).
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3 Enter the character to use for the Token Separator.

4 Click the OK button. 

COLD returns you to the Document Class Information window.

5 To save token concatenation information, click on the OK button. This 
returns you to the Define Report Format window.

6 In the Define Report Format window, select Save from the File menu.

To obtain index values by filter mask:

A filter mask identifies characters that you want to keep and the char-
acters you want to remove from an index value. The filter mask is 
applied to the specified keyword or data. This method is primarily for 
converting data that is a combination of numeric and non-numeric 
characters for storage as a numeric index, such as a social security or 
telephone number. 

The filter mask uses the plus character (+) to indicate inclusion. All 
other characters are ignored. The plus character (+) retains the corre-
sponding data character for the index value, while any other character 
removes the corresponding data character from the index value. You 
might want to use the minus character (-) as the character to indicate 
removal. 

In the following example, you want the numeric index Phone Number to 
store the actual telephone number. However, the phone number in the 
COLD document appears like this, with non-numeric characters:

(800) 123-4546
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You could use this filter mask to remove the parentheses, extra spaces, 
and the dash:

- + + + - - + + + - + + + +

After COLD applies the filter mask, the value stored for the Phone 
Number index is:

800123456.

1 To choose filter mask as the index identification method, select the Fil-
ter Mask button.

2 Enter the index mask you want to use. 

3 Click the OK button. COLD returns you to the Document Class Infor-
mation window.

4 To save the index mask, click on the OK button. This returns you to the 
Define Report Format window.

5 In the Define Report Format window, select Save from the File menu.

Find Index Values Using Offset Coordinates

To find the index value using keyword, COLD uses offset coordinates 
relating to the keyword. You specify the offset coordinates by counting 
the lines and words beginning with one (1) as the offset from the key-
word location of zero (0). Anytime you tell COLD to back up from the 
keyword (number of words and lines), you must include a minus in the 
location.
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The following examples and illustrations explain how to express the 
offset coordinates (–50 to 50 beginning with 1) from the keyword using 
various value locations. The keyword coordinates are 0,0.

Note COLD considers a word as a string of characters with a space on 
either end. When COLD counts words, the number of spaces between 
words is ignored. This example counts as three words:

Cost Center         1012-4BJKS

Offsets 1,0
In this coordinate, the index value is the next word after the keyword 
(zero point) and on the same line as the keyword.
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Offsets –1,0
In this coordinate, the index value is the word immediately before the 
keyword and on the same line as the keyword.

Offsets 1,2
In this coordinate, the index value is the next word after the keyword 
and two lines below the keyword.

C o s t  C e n t e r  1 0 1 2 - 4 B J K S

Coordinates = 1,0

Vertical Offset = 0
(Lines)

Horizontal Offset = 1
(Words)

Zero point

1 0 1 2 - 4 B J K S  C o s t  C e n t e r

Vertical Offset = 0
(Lines)

Horizontal Offset = –1
(Words)

Zero pointCoordinates = –1,0
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Offsets 0,2
In this coordinate, the index value is the next word after the keyword 
and two lines below the keyword.

Offsets 3,2
In this coordinate, the index value is the third word after the keyword 
and two lines below the keyword.

C o s t  C e n t e r

Vertical Offset = 2
(Lines)

Horizontal Offset = 1
(Words)

1 0 1 2 - 4 B J K S

Coordinates = 1,2

Zero point

C o s t  C e n t e r

Vertical Offset = 2
(Lines)

Horizontal Offset = 0
(Words)

1 0 1 2 - 4 B J K S

Coordinates = 0,2

Zero point
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Offsets –3,–2
In this coordinate, the index value is the third word before the keyword 
and two lines above the keyword.

C o s t  C e n t e r

Vertical Offset = 2
(Lines)

Horizontal Offset = 3
(Words)

0 5 2 8L a s t  Y e a r

Coordinates = 3,2
Zero point

Vertical Offset = –2
(Lines)

Horizontal Offset = –3
(Words)

0 5 2 8 L a s t  Y e a r

Coordinates = –3,–2
Zero point

C o s t  C e n t e r
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Specify Filtering, Multiple Templates, & Tables of Contents

Use the Edit Menu commands in the Define Report Format window as 
explained in the table below: 

Page Filter 

You can filter pages from committal using the Edit menu’s Document 
Format command. For example, you can omit a page containing only 
control information or indexing information. You specify the location of 
a search literal identifying this page. Page filtering is applied to the 
unformatted data. So, if page 3 is selected during the filtering process, 
it is not page 3 of every document, but page 3 of the unformatted text. 

Edit Menu Option Description

Table of Contents

Select this option from the Edit menu to indicate the 
location of the table of contents key or keys. When a 
key changes, COLD puts it and its associated page 
number in the table of contents. You can also select a 
background template for each of the table of contents 
pages. 

Multiple Templates
Select Multiple Templates from the Edit menu to add 
the background template definitions that COLD is to 
use on specific pages for this Report Format.

Document Format

This Edit menu command has the following options:

Page filter
Line filter
Default templates
Add, modify, or delete templates

These options are explained on the following pages.
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From the Edit menu, select Document Format to display the Document 
Format window.
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Consider that COLD includes filtered pages in the page count. For 
example, you might decide to filter out page two, but you want COLD to 
extract a value from page three of a document. The program still 
extracts the information from the third page, because page two will not 
be filtered out until after COLD processes the data. For details about 
how COLD processes and filters data, please see “COLD Formatting 
During Data Processing” on page 173.

To extract indexing values from filtered pages:

If you want COLD to perform indexing on filtered pages, you must add 
an environment variable to either your .profile file or the /etc/rc.initfnsw 
file. 

• If the FileNet software starts automatically when you boot your 
system, then add the line below to the /etc/rc.initfnsw file. 

• If you start the FileNet software yourself, or if you log on as “root” 
then add the line below to the .profile file.) 

Enter this line anywhere after the “# Start FileNet IMS” line:

COLD_IGNORE FILTERED_PAGES=0 

Also add this information at the end of the “export” line near the end of 
the same file.

If the environment is set as follows, COLD does not perform indexing 
on filtered pages.

COLD_IGNORE FILTERED_PAGES=1 
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To filter pages:

Enter the following information in the Document Format window’s Page 
Filter section: 

1 In the Line field, enter the line number where COLD can find the page 
filter literal.

2 In the Column field, enter the column number where the page filter lit-
eral begins.

3 In the Literal field, enter the page filter literal value.

The maximum length of a page filter literal is 16 characters. COLD fil-
ters all pages on which this literal occurs. COLD automatically records 
the length in the Length field (next to the Literal field). 

4 To save your page filtering information, click on the OK button. This re-
turns you to the Define Report Format window.

5 From the File menu in the Define Report Format window, select Save.

The following paragraphs explain the Line Filter and Template sections 
in the Document Format window.
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To filter a single page:

This option is only available if your Report Format specifies variable-
page documents. Enter the following information in the Document 
Format window’s Line Filter section: 

1 Select Single Page Filter to activate the Single Page Filter fields.

2 In the Page field, enter the page number to filter.

3 To save your page filtering information, click the OK button. This re-
turns you to the Define Report Format window.

4 From the File menu in the Define Report Format window, select Save.

Line Filter

COLD can extract information such as index values or a Report Format 
literal from a filtered line of data that ultimately does not appear in the 
final output. For example, you might want a social security number 
extracted from a line of data that includes other information that is not 
relevant to your report.

If you use filtered data in creating the table of contents or in indexing, 
the data does display in the table of contents and index.
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You can filter lines in two ways: 

• Line filtering by line number filters only one line per page, and only 
that line can be filtered for the entire Report Format. When filtering 
by line number, you can also filter part of a line.

• Line filtering by search literal filters out more than one line per 
page. COLD filters any lines containing the search literal in the 
specified location. 

Consider that COLD includes filtered lines in the line count (as 
opposed to any channel control character that ignores a line). For 
details about how COLD processes and filters data, please see 
“COLD Formatting During Data Processing” on page 173.

To filter a line by line number:

To accurately figure the line number to filter, run the Preview Document 
program with no line filtering. From the output window, identify the line 
number that you want to filter out. See “Preview Documents” on 
page 134.

Enter the following information in the Document Format window’s Line 
Filter section: 

1 Click the Single Line Filter button to activate the single line filter fields.

2 In the Line field, enter the line number to filter.

3 To save your line filtering information, click the OK button. This returns 
you to the Define Report Format window.

4 From the File menu in the Define Report Format window, select Save.
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To filter lines by search literal:

Enter the following information in the Document Format window’s Line 
Filter section: 

1 In the Column field, enter the column number in which the search lit-
eral begins.

Note Make sure that none of the filter buttons are selected. These filter but-
tons are the Single Line Filter, Single Page Filter, and Partial Line Fil-
tering buttons. The search does not work properly if any are selected.
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2 In the Literal field, enter the value that COLD searches for. This field 
takes a maximum of 16 characters. COLD automatically displays the 
length of the search literal in the Length field.

3 To save your line filtering information, click the OK button. This returns 
you to the Define Report Format window.

4 From the File menu in the Define Report Format window, select Save.

To use partial line filtering:

Enter the following information in the Document Format window’s Line 
Filter section: 

1 To activate the Partial Line filtering fields, click on the Partial line filter-
ing button.

2 In the Starting Column field, enter the column number where line filter-
ing should start.

Note If you leave this field blank, the entire line is removed.

3 In the Filter Text Width field, enter the number of characters to omit. 

4 To save your line filtering information, click the OK button. This returns 
you to the Define Report Format window.

5 From the Edit menu in the Define Report Format window, select Save.
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Select a Default Template 

Use the Template field in the Document Format window to specify a 
default template for pages that do not have an associated template. 
For example, you might want to display a simple border and your com-
pany logo. 

To use background templates for specific data pages, see “Add, 
Modify, or Delete Templates” on page 115.

To select a default background template:

Enter the following information in the Document Format window’s Tem-
plate section:

1 To display a list of the background template definitions on your system, 
click the down arrow next to the Template field.

2 Click the template of your choice to select it.

3 To define the text formatting for the pages using this template, click the 
Page Setup button.

Use Page Setup to define the font, typeface style, characters per inch, 
lines per inch, and top and left margin offsets. If you do not select Page 
Setup, COLD uses default settings. The default settings are based on 
the format of your data.

For details on Page Setup settings and information on how COLD 
applies the default settings, see “The Page Setup Dialog Box” on 
page 121.



Preparing for an Import Job

Define Report Format

November 2008 COLD Handbook, Release 4.1.2 115

4 Click the OK button. This returns you to the Document Format window.

5 Click OK to return to the Define Report Format window.

Add, Modify, or Delete Templates

Use the Edit menu’s Multiple Templates command to select multiple 
background templates to display with specific data pages. You specify 
the line and column where COLD can find a literal that links that page 
to a background template. Whenever COLD finds this literal, it applies 
the template to that page. You can also use the Multiple Templates 
command on the Edit menu to add, modify, and delete templates from 
your Report Format file.

The same rules that apply to tables of contents (TOC) and data pages 
also apply to templates. Without a TOC, you can have a maximum of 
1,000 pages in your template. If you select the Enable Table of Con-
tents button in the Define Report Format window and specify one TOC, 
you can have 999 pages. With two TOCs you can have 998 pages. 
And, with three TOCs you can have 997 pages in the template.

CAUTION COLD searches each page sequentially for the literal that identifies the 
template. On pages that contain multiple matches, only the first one is 
recognized. The program ignores subsequent matching literals on the 
page. 

If an accidental match occurs—if COLD finds a literal that matches the 
wrong template—it still applies that template. Analyze your data care-
fully to make sure that no accidental matches can occur. 
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To add a template to a Report Format:

1 From the Edit menu, select Multiple Templates to display the Multiple 
Templates window listing the template definition files available on your 
system.

2 On the Available Template list, click on the template that you want to 
add to your Report Format. This action selects the template.

3 Click the Add button to display the Template Identifier window. COLD 
displays the selected template name in the Template Name field.
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4 In the Line and Column fields, specify the line and column in the for-
matted data where COLD can find the literal for this template.

5 In the Literal field, enter the value. The maximum length of this field is 
20 characters. COLD automatically records the length in the Length 
field when you exit the dialog box.

6 Click the Page Setup button to define the text formatting for the pages 
using this template.
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Page Setup is where you define the font, typeface style, characters per 
inch, lines per inch, and top and left margin offsets. If you do not select 
Page Setup, COLD uses default settings. The default settings are 
based on the format of your data. 

For details on Page Setup settings and information on how COLD 
applies the default settings, see “The Page Setup Dialog Box” on 
page 121.

7 After completing your entries, click the OK button. COLD returns you to 
the Multiple Templates window and displays the template in the Se-
lected Templates box. If you have two matches, the first parameter’s 
template is chosen.

You can continue to add templates to your Report Format file. 

8 To exit from this window, click the OK button. COLD returns you to the 
Define Report Format window.

9 In the Define Report Format window, select Save from the File menu.



Preparing for an Import Job

Define Report Format

November 2008 COLD Handbook, Release 4.1.2 119

To modify a template in a Report Format:

1 From the Edit menu, select Multiple Templates to display the Multiple 
Templates window with a list of the template definition files available on 
your system.

2 In the Selected Template List, select the template that you want to 
change.

3 Click the Modify button to display the Template Identifier dialog box.

4 Change any of the values in the line, column, or literal fields.

5 To change the font, style, characters per inch, lines per inch, or margin 
settings, click on the Page Setup button.

For details on Page Setup settings and information on how COLD 
applies the default settings, see “The Page Setup Dialog Box” on 
page 121.

6 Click the OK button. COLD records your changes. You can continue to 
modify other templates.

7 To exit from this window, click the OK button. COLD returns you to the 
Define Report Format window.

8 In the Define Report Format window, select Save from the File menu.
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To delete a template from a Report Format:

1 From the Edit menu, select Multiple Templates to display the Multiple 
Templates window listing the template definition files available on your 
system.

2 In the Selected Template List, select the template that you want to 
delete.

3 Click the OK button. COLD prompts you:

Template “<template-name>” will be removed from the report. Are 
you sure?

4 To remove the template from the Report Format file, click the Yes 
button. The template name is removed from the Selected Template 
List, but is still available on your hard disk. You can continue to delete 
templates from your Report Format.

5 To exit from this window, click the OK button. COLD returns you to the 
Define Report Format window.

6 In the Define Report Format window, select Save from the File menu.
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The Page Setup Dialog Box

In the Page Setup dialog box, you specify the font, typeface style, char-
acters per inch, lines per inch, and top and left margins for pages in 
your document. The following paragraphs explain these steps.

The Page Setup function is especially useful for fine-tuning the appear-
ance of your output data and positioning it correctly on the background 
template. You might need to experiment with the settings to position 
your data satisfactorily. Use the Preview Documents function or print a 
test copy to check how the data aligns with the template form. See 
“Preview Documents” on page 134 for details. 

You can access the Page Setup dialog box by clicking the Page Setup 
button from various dialog boxes as follows: 

The following is an illustration of the Page Setup dialog box:

Dialog Box Possible Options

Table of Contents
Specify page setup values only for the table of con-
tents page.

Template Identifier
Specify page setup values only for those pages where 
the selected template identifier appears.

Document Format

Specify page setup values for all pages in the docu-
ment except the table of contents page. You can also 
specify page setup values for those pages in the body 
of the document to which you assigned a specific tem-
plate (in the Template Identifier dialog box).
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The following pages describe how you can specify page setup values 
or use COLD’s default page setup.
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Font

For printing your data and table of contents pages, you can select one 
of the fonts that COLD provides, or you can leave the Default setting 
(shown in the table below) as is. The program selects fonts based on 
the conditions listed in the following table, which are in effect on most 
platforms.

Note If you are going to configure your system for multi-byte data charac-
ters, you must select the Japanese font in this field.

The four Gothic fonts are included with the COLD software. The Cou-
rier typeface is also provided in a variety of characters per inch and 
pixel widths. 

Note During document preview, the Gothic fonts display as the Courier type-
face on most platforms. See the table on page 124 for a complete list 
of available Courier font sizes. Other FileNet applications might display 
the Gothic fonts using something other than Courier.

Conditions Font Name Pixel Width
Characters per Inch

(Horizontal)

More than 85 characters per line. Gothic 6 5 20.00

Has background template.
More than 85 characters per line.

Gothic 8 6 16.67

Fewer than 86 characters per line. Gothic 9 8 12.50

Has background template.
Fewer than 86 characters per line.

Gothic 12 10 10.00
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The Courier and Japanese fonts are equivalent to the Gothic typeface.

To select a font, click the down arrow next to the Font field in the Page 
Setup dialog box. Select the font of your choice.

Lines/Inch

You can select a value of six or eight lines per inch (LPI) for printing 
data and table of contents pages, or you can accept the default. If you 
accept the default, the data displays and prints with a standard line 
spacing (LPI) for the selected font. 

To change lines per inch, click the down arrow next to the Lines/inch 
field. Select the setting of your choice.

Courier & Japanese Font Sizes

Pixel Width
Characters per Inch

(Horizontal)

5 20.00

6 16.67

7 14.29

8 12.50

9 11.11

10 10.00

11 9.09

12 8.33
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Top/Left Margin in Inches

Your background templates might have borders or graphic objects that 
intrude on the data. 

You can move the data down and to the right by adjusting the left and 
top margins. You can also use margin settings to adjust the text to the 
page even if a template is not used. 

The default offset is 0.0 inches. For example, to offset from the top or 
left margin by 1½ inches, you would enter the value 1.5.

To set the top or left margin, enter the desired value in inches in the 
appropriate field.

See also “Online Template Alignment” on page 141.

Characters/Inch

The following table explains the Characters/inch field.:

Font Characters/Inch Field

Default
This field is blank since the characters-per-inch varies depend-
ing on your data.

Gothic
This field displays the characters-per-inch, but you cannot 
change the value.

Courier/
Japanese

You can change the characters-per-inch setting to range from 
8.33 to 20.

To change characters per inch for the Courier or Japanese font, 
click the down arrow next to the Characters/inch field. Select the 
setting of your choice.
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Style

Currently, COLD offers only the Medium Roman style.

Save the Report Format File

After completing the Report Format file, you must save it. COLD stores 
the Report Format file in the following directory:

/fnsw/local/cold/formats

To save the Report Format file, select Save from the File menu. The 
File menu also offers the Save As command that you can use to save 
the Report Format file with a new name, keeping the original intact.

Delete the Report Format File

The following steps explain how to remove a Report Format from 
COLD’s list of available Report Format files. 

1 To display the Define Report Format window, click the Define Report 
Format button on COLD’s Main Menu. 

2 Click the List button next to the Report Format Name field. COLD dis-
plays the Selection Box containing a list of all Report Format files avail-
able on this system.

3 Select the desired Report Format file from the list.

4 From the File menu, select Delete.
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Define Import Job
Before you begin the procedures in this section, collect the data listed 
in “How to Begin” on page 31. You might also want to read the sec-
tion, “COLD Formatting During Data Processing” on page 173.

The import job file contains the information that COLD requires to pro-
cess specific data. For example, if you are running a “Nov1998” payroll 
job, it might contain Report Formats for extracting tax withholding, 
vacation, and payroll deduction information. 

The import job file is stored as a text file in the following directory:

/fnsw/local/cold/jobs 

Create the Import Job File

From the COLD Main Menu, select Define Import Job to display the 
Define Import Job window. Enter import job information in this window 
as indicated in the following paragraphs. 
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To specify a job name:

1 To display a Selection Box listing import job files currently on your sys-
tem or to name a new import job, click the List button next to the Job 
name field.
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2 In the Selection Box, select a name or enter a new name.

Use standard file naming conventions. The maximum field length is 14 
characters. 

3 Click the OK button. COLD returns you to the Define Import Job win-
dow.

Job Description

If you are creating a new import job file, enter a job description that is 
meaningful to you in the Description field. The maximum field length is 
30 characters. 

Fixed-Length Line

COLD supports fixed-length and variable-length lines (records). If you 
choose Fixed-Length Line, all the characters on a line are committed. 

Characters Per Line

In the Characters Per Line field, enter the number of characters per 
line of data, including the channel control character. This is a required 
field. The maximum value is 256.

All pages in an import job must have the same number of characters 
per line. If the data is on tape, the number of characters per line must 
be the same as the record size. The number of characters per line 
includes the channel control character in the first column. 
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Variable-Length Line

COLD supports fixed-length and variable-length lines (records). For 
example, your lines of data might be 250 characters long, but there is 
no data on most of each line, and you want to commit only the data. In 
this case, you might want to choose the Variable-Length Line option. 

If you select Variable-length Line, you must specify the character or 
characters that signal the end of the line. You can specify one or two 
end-of-line (EOL) characters. For example, your data might have a car-
riage return and a line feed character at the end of each line. If your 
data has a carriage return only, like the following illustration, then 
select only one EOL character. 
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End-of-Line Characters

Since COLD does not define the end-of-line characters other than as 
“non-printable character,” you need to know the hexadecimal values of 
your end-of-line characters.

Typically, UNIX files use a line feed character (0x0a), and DOS files 
use a carriage return (0x0d) and a line feed (0x0a) character. The 
allowable range of characters is 0x01 to 0xff.

If you don’t know what end-of-line character(s) your data uses, please 
see your system administrator.

Specify a Channel Control File Name

To specify the channel control file for the import job, click the down 
arrow next to the Channel control file name field and select from the list 
of files located in /fnsw/local/cold/channel.

Select a Report Format

To specify one or more Report Format files for the import job, select a 
name from the list in the Available Reports field. Click the Add button 
after each selection. COLD displays the selected Report Formats in 
the Selected Reports field.

To remove one or more Report Format files for the import job, choose a 
name from the Selected reports field. Click the Delete button after 
each selection.
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CAUTION The program searches each page sequentially for the literal that speci-
fies the Report Format and uses the first match it encounters. If there 
happens to be an accidental match that applies to the first Report 
Format you specify, the program applies that Report Format. 

The simplest way to avoid this problem is to make sure that your report 
literals are sufficiently different so that accidental matches do not 
occur. You need to know which pages contain data matching the spec-
ified Report Formats and list the Report Formats in the appropriate 
order.

Save the Import Job File

After completing the import file, you must save it. COLD stores the 
import job file in the following directory:

/fnsw/local/cold/jobs

To save the import job file, select Save from the File menu. The File 
menu also offers the Save As command that you can use to save the 
Report Format file with a new name, keeping the original intact.
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Delete the Import Job File

To remove an import job from COLD’s list of available import job files:

1 From the COLD Main Menu, click the Define Import Job button to dis-
play the Define Import Job window. 

2 Click the List button next to the Job name field. COLD displays the Se-
lection Box containing a list of all import job files available on this sys-
tem.

3 Select the desired import job file from the list.

4 From the File menu, select Delete.
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3
3Running an Import Job

This chapter describes the options that are available after you have 
specified the job parameters discussed in the previous chapter. This 
chapter includes:

• “Preview Documents” on page 134

• “Import Documents” on page 145

• “View Import Log” on page 150

• “Automating COLD” on page 154

• “Batch Committal” on page 164

• “Printing Job Files” on page 165

Preview Documents
Use the Preview Documents function to display pages as they would 
look in an actual import job. This feature is for previewing and verifying 
only; no documents are committed. The Preview Documents function 
runs only on the display console. 

Note Keep in mind that when you are in Preview Documents mode, you are 
not running an import job. It’s easy to confuse the Preview Documents 
program with the Import Documents program; they look very similar.
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Select a COLD Job to Preview

1 From the COLD Main Menu, select Preview Documents to display the 
Preview Document window.

2 Click the List button next to the COLD job name field to display the Se-
lection Box, which lists the import job files that are stored on your sys-
tem in the directory /fnsw/local/cold/jobs.

3 Select a job and click the OK button. COLD returns you to the Preview 
Document window and displays the job name and the job description. 
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4 If you want to preview non-ASCII data, you need to select a translation 
map so that COLD can translate the data to ASCII format. Click the 
down arrow next to the Character Set Translation field to display the 
character translation maps available on your system. 

• To map EBCDIC data to the 8859-1 character set, select the 
ebcdic_8859-1 file.

• To import COLD data formatted with a character set other than 
EBCDIC or ASCII, you can create your own character set transla-
tion map. For instructions on how to do this, see “Define a Char-
acter Translation Map” on page 171. 

5 Select the input source type. Your input data can be on tape or disk. 

• Disk—If the input source is a disk file, click the Disk button. Skip to 
Step 6 on page 137.

• Tape—If the input source is a tape, click the Tape button to activate 
the Tape Service and Volume Identifier fields. 

- Tape Service—The tape services are specific to your installa-
tion. Tape service identifies the tape density, block size, char-
acter set, and label information. Click the down arrow next to 
the Tape service field to select the desired tape service. 
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CAUTION COLD does not process more than the first tape of a multi-tape run if 
subsequent tapes are not labeled.

- Volume Identifier—The text in the Volume Identifier field. If 
you do not specify a volume identifier, the program searches for 
the file name on the tape currently in the tape drive. For an 
example of a volume identifier, see “Tape Labels” on 
page 168. 

6 In the File Name field, enter the pathname of the file containing the 
data. If you aren’t sure of the pathname, click the Select button to find 
the full pathname of the file containing the ASCII data.   

For example:

fnsw/local/cold/data/NNTdata.DAT

If you do not specify a file name for data on a tape, the Import program 
processes all files on the tape.

7 To preview the specified COLD import job, click the OK button. 

If there were any problems with the data or job files during the preview 
attempt, COLD displays information regarding the problems in the Info 
Message field. You can look at the Import Log file to find the problem. 
For more information, see “View Import Log” on page 150.

Preview & Search Data

With the Preview Documents program, you can view input data, output 
data, and job parameters. You can also search the data. 
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The table below lists the four dialog boxes that display together and 
their purpose.

1Acct 1028

    288051
    10/12/1999
    Spring Water
Rte 231-002
    5 gallon
    2
    10/26/1999
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Dialog Box Purpose

Preview Input Data For viewing the raw data. Display only.

Preview Output Data
For viewing the data as it appears using the formatting from your specifica-
tions and background templates. This window displays when you select a 
Preview Seek method.
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Note You cannot restart a job in Preview Documents mode. COLD creates 
the checkpoint files that it uses for restarting only during an actual 
import. COLD creates a log file when you run either the Preview Docu-
ments program or the Import program. See “View Import Log” on 
page 150 for details.

Preview Seek Methods & String Location

In the Preview Seek Methods dialog box, you can determine how the 
search of COLD pages is done. The following paragraphs explain 
these methods. 

Single Step—To step through pages one at a time, select the Single 
Step button and click OK. 

Run—To simulate an actual import job, select the Run button and click 
OK. You can use the Stop button at any time to stop the run process. 
For example, you might want to use the Stop button if a run is taking 
too long. 

Go To Specific Page—To display a specific page in a document, 
select the Go To button, enter the document and page numbers, and 
click OK. 

COLD Preview Job 
Parameters

Shows the parameters for the job, data, and selected index values. Display 
only.

COLD Preview Seek 
Methods

Controls the various ways to access COLD pages.

Dialog Box Purpose
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Skip Pages—To skip a specified number of pages to see the page you 
want to preview, select the Skip button. Enter the number of pages you 
want to skip, and click OK. The Skip feature is useful for accessing 
random pages across documents. 

Search for Specified String—To search for a string that you specify, 
select the Search button, enter a search string, and click OK. The 
COLD software searches all text pages for the specified string. The 
search starts from the current page and goes across document bound-
aries. The search is case-sensitive and finds matches within a line, but 
not across line boundaries. 

You can use the Stop button at any time to stop the search process. 
For example, if a search is taking too long, you might want to use the 
Stop button.

When the software finds a match, it updates the Matched String Loca-
tion section in the COLD Preview Seek Methods dialog box to reflect 
the line and column of the matched string within the displayed page. 

If a match is not found, COLD displays a message after the end of the 
file is reached, the preview windows (input, output, job parameters, 
and seek methods) close, and control returns to the Preview Docu-
ment dialog box. The Info. Message field on the Preview Documents 
dialog box explains the reason the search was unsuccessful. COLD 
only identifies the first occurrence of a string per page.

Matched String Location—The Matched String Location display 
fields show the line and column in the formatted data where a match to 
the search string was found. 
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Action Buttons—The action buttons listed below are at the bottom of 
the COLD Preview Seek Methods dialog box. 

Online Template Alignment 

You can associate a template with a document when the document 
report format is specified. With the Preview Documents, Online Tem-
plate Alignment feature, you can adjust how the document and tem-
plate align when displayed or printed. The adjusted template can then 
be committed as a new document. 

Note If your server platform is HP9000, make sure the Storage Library 
server has been configured as a Font server for COLD according to 
the instructions in the IS Upgrade Procedures. This ensures that 
COLD documents and templates align correctly. Also see IS Installa-
tion and Configuration Procedures. To download IBM FileNet docu-
mentation from the IBM support page, see “Accessing IBM FileNet 
Documentation” on page 16.

Button Function

OK
After you select a search method and enter the parameters, click the OK button to start the 
search.

Stop To stop the process when in Run, Search, or Skip mode, click the Stop button. 

Help To access the COLD help system, click the Help button.

Align
To access the online template alignment feature, select Single Step mode; then click the 
Align button. See “Online Template Alignment” on page 141. 

Cancel

To close all the preview dialog boxes, click the Stop button to stop a search if one is running; 
then click the Cancel button on the COLD Preview Seek Methods dialog box. The Preview 
Documents dialog box remains open. 

To close only the COLD Preview Job Parameters dialog box, click the Cancel button on this 
dialog box. The other dialog boxes remain open.
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See “Define Report Format” on page 55 for more information about 
templates. 

To adjust template alignment:

This procedure is useful for making minor template alignment 
adjustments.

1 If you want to page through the data to check alignment, click the Sin-
gle Step button on the COLD Preview Seek Methods dialog box to se-
lect single step mode.

2 Click the Align button to activate the Preview Output Data window. The 
template is shown in white.

Cool Water, Inc.
Account No.

�����������
���
���

00.00
27.00

$     27.00

Invoice No.

Delivery Date

Type

Route No.

Quantity

Next Delivery

288051

10/12/2000

Spring Water

231-002

2

10/26/2000

Previous Balance:
Invoice Total:
Amount Due:

1028

File
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Tip Before you align a template, you might want to record its original docu-
ment ID number, because each time the template is aligned, it is saved 
with a new document ID number. So if you don’t record it, you could 
lose the original document ID. This process ensures that you always 
have a copy of the template before the change was made. But, if a 
template is aligned many times, it can be confusing if you don’t have a 
record of the document ID number.

3 Use any or all of the methods in the following table to align the 
template:

Note Sizing can only be done in one direction at a time; horizontally or 
vertically.

4 After you complete template alignment, pull down the File menu on the 
menubar in the Preview Output Data window. The menu options are 

How To… Procedure

Move the entire 
template

Click anywhere on the body of the template. This action displays a large 
cross-shaped pointer, which you use to grab and move the template.

Change the template’s 
width

Click anywhere on the right edge of the template. This action displays a small 
cross-shaped pointer that you can use to grab and drag the right edge of the 
template to the right or left.

Change the template’s 
height

Click anywhere on the bottom edge of the template. This action displays a 
small cross-shaped pointer with which you can grab and drag the bottom 
edge of the template up or down.
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Save or Exit. The following table explains what happens when you se-
lect Save and when you select Exit: 

5 Click OK to return to the Preview Seek Methods dialog box. 

If no changes were made, the Preview Seek Methods dialog box 
becomes the active window again. 

If the template was changed, COLD displays a popup dialog box. The 
options in this popup are Save, Discard, and Cancel. 

• Click Discard to exit without keeping the changes and return to the 
Preview Seek Methods dialog box. This dialog box has a Cancel 
button, should you decide not to save the changes. If you click the 
Cancel button in the Preview Seek Methods dialog box, another 
pop-up menu displays with the message: “changes will not be 
saved.” Click the OK button to exit without saving.

• Click Cancel to return to the Preview Output Data window.

File Menu Options Results

Save

• Saves changes to the template.

• Commits the template as a new document.

• Updates the COLD templates file, which maps template names to the 
template document ID numbers.

• Displays the new document ID number for the modified template.

Exit

If the template was changed, selecting Exit displays a popup dialog box. The 
options in this popup are Save, Discard, and Cancel. 

If you select Discard in the popup, any changes to the template are lost.

if you select Cancel in the popup, changes are not lost. You can continue to 
adjust the template.
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Import Documents
Use the Import Documents function to start processing the COLD 
data. This function:

• Reads the data from the hard disk or tape

• Processes the data according to the instructions in the Channel 
Control and Report Format files

• Inserts the index values in the index database

• Writes the documents to optical disk

• Generates a log file

The program terminates if no data is found to match the report formats 
specified in the Import Job file.

Start a New Import Job

Normally, when you start an import job, it’s a new set of data. You can 
also restart an interrupted or canceled import job. If you are starting a 
new import job, follow the steps under the heading, “To start a new 
import job:” on page 145. If you are restarting a canceled or inter-
rupted import job, see “Restart an Import Job” on page 148.

To start a new import job:

The following procedures explain how to start a new import job.

Note If you are importing non-ASCII data, click the down arrow next to the 
Character Set Translation field to display the character translation 
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maps available on your system. For details, see the information on 
page 136.

1 From the COLD Main Menu, select Import Documents. This displays 
the Import Document window.

2 Click the No button to indicate that this is not a restart.

3 Click the List button next to the COLD Job Name field to display the 
Selection Box listing import job files that are stored on your system in 
the /fnsw/local/cold/jobs directory.
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4 Select a job and click the OK button. COLD returns you to the Import 
Document window and displays the job name and the job description.

5 Select the input source type. Your input data can be on tape or disk.

• Disk—If the import source is a disk file, click the Disk button. 

• Tape—If the import source is a tape, click the Tape button to acti-
vate the Tape service and Volume identifier fields.

- Tape Service—The tape services are specific to your installa-
tion. Tape service identifies the tape density, block size, char-
acter set, and label information. Click the down arrow next to 
the Tape service field to select the desired tape service.   

CAUTION COLD does not process more than the first tape of a multi-tape run if 
subsequent tapes are not labeled.

- Volume Identifier—Enter the volume identifier in the Volume 
identifier field. If you do not specify a volume identifier, the pro-
gram searches for the file name on the tape currently in the 
tape drive. For an example of a volume identifier, see “Tape 
Labels” on page 168. 

6 Enter the name of the tape file containing the data in the File name 
field, or click the Select button to select the full pathname of the disk 
file containing the ASCII data.   

For example:

/fnsw/local/cold/data/NNTdata.DAT

If you do not specify a file name for data on a tape, the Import program 
processes all files on the tape.
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7 Click OK to import the COLD job you specified.

If there were any problems with the data or job files during the import 
attempt, COLD displays information regarding problems in the Info 
Message area. 

Restart an Import Job

COLD periodically checks its progress during an import run and cre-
ates a checkpoint file indicating the last record processed in that job. 

When an interruption to the import process occurs, COLD can restart 
the process by accessing the checkpoint file to determine where the 
interruption occurred.  If the restart job runs to completion, COLD auto-
matically deletes the checkpoint file.

Note Restart should only be used if you suspend the job by clicking the 
cancel button NOT after an abnormal failure such as a power outage or 
system shutdown. Import job restart after an abnormal failure is not 
reliable. Indexes could be lost. In the case of an abnormal failure we 
recommend that you redo the Import Job from the beginning.

The checkpoint file name is in the format ckp.<job_id>, where <job_id> 
is the unique date-time stamp (mm:dd:hh:mm:ss format) for the job. 
The import program updates the checkpoint file every time it gets a 
block of 1,000 document IDs from Image Services. COLD updates the 
checkpoint file when a batch is committed.
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The following paragraphs explain restart procedures.

To restart a disk file import job:

1 From the COLD Main Menu, select Import Documents to display the 
Import Document window. 

2 Click the Yes button to indicate that this is a restart.

3 To display the Selection Box listing checkpoint files, click the down ar-
row next to the Job ID field. Unless several jobs have been interrupted, 
there should be only one job listed.
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4 Select the file for the job that you want to restart. 

5 Click the OK button. COLD returns you to the Import Document win-
dow and displays the import job name, its description, the input source, 
and the data file name.

6 To restart the job, click the OK button in the Import Document window.

To restart a multi-tape import job: 

Remount the tape that was running when the job was suspended and 
then follow the steps outlined under the heading “To restart a disk file 
import job:” on page 149. 

View Import Log
While running an import job, COLD generates a Log file containing 
information about the session, such as start time, stop time, the ID 
numbers of the first and last documents committed, and number of 
pages processed. You can view this log from any workstation on the 
system. 

To view an import log:

1 From the COLD Main Menu, click View Import Log to display the COLD 
Import Log window. COLD displays the log for the most recent job.
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2 To view another log, click the down arrow next to the Log file name 
field. 

3 Click on a log to select it. COLD returns you to the COLD Import Log 
window and displays the log information.
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The Import Log Fields

The following table describes the fields in the COLD Import Log dialog 
box. 

Field Description

Log File Name

Log files are named in the format:

log.<mmddhhmmss>

where <mmddhhmmss> is the date and time the job started.

The log files are stored in the directory /fnsw/local/logs/cold for UNIX Servers 
or \fnsw_loc\logs\cold\ for Windows Servers. 

Job Name This is the name that you assigned when you defined the import job.

Description
This is the job name description that you assigned when you defined the im-
port job.

Operator This field displays the user login name, domain, and organization.

Source Input This is the pathname of the data’s location.

Start, Stop,
Elapsed Time

These fields display the date and time (to the second) that the import job 
started, stopped, and how long the import job took. (How the date displays is 
determined by the machine language and is always hours, minutes, and 
seconds.)

Total Warnings

If any errors occur during an import job, COLD indicates the number of warn-
ing messages in this field and displays a View button next to the number. 
Click the View button to see the list of errors in the error log. For more infor-
mation on the error log, see “Error Log” on page 153.

Document Classes 
Processed

This is a list of all the document classes that you assigned to the report for-
mat(s) used in the import job.

First/Last Doc. ID 
Committed

The First Doc. ID Committed field indicates the lowest document ID number 
committed for the session. The Last Doc. ID Committed field indicates the 
highest document ID number committed for the session. These fields do not 
necessarily indicate that all document numbers in that range are committed. 
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Error Log

The error log contains the following information regarding an import 
job:

Reel Number (if tape)

Block Number

Offset within the Block

Document ID

Page Number

Error Tuple and Message Text 

To view the Error log, click on the View button next to the Total Warn-
ings field in the COLD Import Log dialog box.

Blank Fields
If you are looking at a COLD Import Log for a Preview job, the fields in the 
committed/processed section are blank, and the Completion Status field in-
dicates “Job completed.”

No. of Pages Pro-
cessed/Committed

These two fields display the number of pages processed and the number of 
pages committed during the import job.

No. of Documents Pro-
cessed/Committed

These two fields display the number of documents processed and the num-
ber of documents committed during the import job.

Completion Status
This is the status of the import job. The status is either “Job completed” or 
“Job was cancelled.”

Field Description
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Automating COLD
Automated or unattended operation of COLD could have benefits to 
you or your installation. Because COLD processing can slow down 
other activities on your IS server, and interfere with other activities on 
the system, you might want to process COLD data at a time when 
system activity is low. To run COLD unattended, use the 3770 daemon 
program. 

The 3770 program can be left running continuously for regular pro-
cessing of data files. However, unless you have configured your 
system to automatically start up the daemon along with the FileNet 
software, you must restart the daemon every time you reboot the IS 
server. For information on configuring your system to automatically 
start the daemon, see “Start the 3770 Daemon Automatically” on 
page 162. For information on manually starting the daemon, see 
“Start the 3770 Daemon Manually” on page 163.

You could transfer files every night from your mainframe to the IS 
server for input to COLD via ftp, RJE/SNA services, rcp, etc. You could 
then have the 3770 daemon import the files to COLD.

Note If importing data to COLD by way of RJE/SNA, RJE typically adds the 
control characters “JCL,” or other extraneous characters. You should 
remove these characters from the data. COLD processes these char-
acters as data.

Most of the procedures described in this section require that the user 
who wants to make the changes be a member of fnadmin or fnop, or 
log on using fnlogon.
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Overview of 3770 Daemon Processing

The daemon searches the IS server for input files with a prefix of IN_, 
CO_, or TX_. These prefixes indicate that a file is there for COLD to 
process. COLD processes files on a “first in, first out” basis, including 
multiple files submitted for the same job.

When the 3770 daemon program finds an input file, it finds the name of 
the COLD import job file by reading the characters after the prefix and 
then locates the import job file in the /fnsw/local/tmp/3770 directory. 
You create the import job file in COLD’s Define Import Job program. 
See Chapter 2, “Preparing for an Import Job,” on page 30. The 
import job file specifies the record length, the channel control file, char-
acters per line, and the report formats to apply to the data.

After the 3770 daemon program matches a data file to an import job 
file, it starts COLD. COLD then does the following:

• Reads the data file.

• Processes the data according to the instructions in the Channel 
Control and Report Format files.

• Inserts the index values in the index database.

• Writes the documents to optical disk.

• Deletes the file, if it was processed successfully. If an error 
occurred during processing, COLD renames the file 
“error_<originalfilename>” and stores it in the same place as the 
original file (/fnsw/local/tmp/3770). If you prefer, you can configure 
COLD to save the data file instead of deleting it. 
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• Generates a log file, which COLD stores in the /fnsw/local/logs/cold 
directory. For more information about log files, refer to “View 
Import Log” on page 150.

File-Naming Conventions for Automatic Processing

The 3770 daemon searches the /fnsw/local/tmp/3770 directory for files 
with specific prefixes. This section explains the conventions you should 
use when naming COLD files. The following list describes how to name 
the files that you transfer to the IS server: 

IN_aaa…a[.suffix]

CO_aaa…a[.suffix]

TX_aaa…a[.suffix]

where:

IN_
Indicates that the data is in EBCDIC format. COLD automatically converts EBCDIC for-
mat to ASCII.

CO_ Indicates that the data is in ASCII format.

TX_ Indicates that the data uses a user-defined character translation table. 

aaa…a The name of a COLD import job file located in the /fnsw/local/cold/jobs directory

.suffix

An optional string to identify multiple data files for the same job. For example, “.1” could 
identify the first file in the sequence, “.2” the second, etc. The actual sequence of process-
ing is determined by the order in which files are submitted to the directory rather than by 
the alphanumeric sequence of the suffixes. You can use the filename suffix to submit 
more than one data file for the same job.
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The COLD 3770 Command & Options

The command and its required accompanying options that you enter at 
the system prompt to start the COLD 3770 daemon is: 

cold_3770 [<option> <info>]

Command line options control the function of the daemon. Some 
options can be used alone; some must be used with other options 
entered on the command line.

The table below shows the options and their functions.

Options Function Comments

–d Defines the data file directory
Can be used alone or 
with other options. 

–m

Defines the marker file directory (For a 
definition of marker file, see “Define 
Marker File Directory (–m)” on 
page 159.)

Must be used with –d. 
Cannot be used alone.

–s Saves the data files
Must be used with –m. 
Cannot be used alone

–t Defines the character translation table
Can be used alone or 
with other options. 

–p Defines polling frequency
Can be used alone or 
with other options. 
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Syntax

cold_3770 [[–d <data_dir>] [–m <marker_dir> ] [–s]] 
[–t <char_trans_file_name>] [–p <secs>] [–h] 

Define Directory Options (–d, –m, –s)

The options to define directories are –d, –m, and –s. (For definitions of 
these options, see the table on page 157.) 

Define Data File Directory (–d)

The default data file directory is /fnsw/local/tmp/3770. If you want to 
use this directory, you do not need to use the –d option or define a 
directory.

To define another data directory, enter the command below at the 
system prompt: 

cold_3770 –d <data directory pathname>

Command line example:

cold_3770 –d /fnsw/local/tmp/3770/data

–h Displays a usage report (syntax help)
Can be used alone or 
with other options. 

NOHUP

Detaches the daemon process from 
your UNIX terminal, thereby eliminating 
program blocks. (For more information, 
see “To define a translation table 
for UNIX platforms:” on 
page 161.)

This is a UNIX com-
mand. COLD will not 
run if you use this com-
mand on an Windows 
Server.

Options Function Comments
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You can use the –d option alone, or with the –m option, or with the –m 
and –s options. If you use the –m and –s options on the same com-
mand line, you must also use the –d option. Files in the data file direc-
tory are the actual data files that COLD will process. 

Define Marker File Directory (–m)

CAUTION There is a danger in using the default for the marker file directory 
because the default marker file directory and the data file directory are 
the same, /fnsw/local/tmp/3770. When the data and marker directories 
are the same, processing can begin on the data files before the data is 
completely transferred. This premature processing can cause files to 
be processed incorrectly or even deleted. 

The existence of a file in the marker directory indicates to COLD that 
the corresponding file in the data directory is ready to be processed. 
The files here are just markers. Data files must be completely trans-
ferred into the data directory before the marker file is created in the 
marker directory.

The –m option defines the marker file directory. It must be used with 
the –d (define data directory) option. You can use the –m option with 
other options but it cannot be used alone. 

To specify the marker directory, enter the command below at the 
system prompt.

cold_3770 –d <data_dir> –m <marker_dir> 

Command line example:

cold_3770 –d /fnsw/local/tmp/3770/data –m /fnsw/local/tmp/
3770/marker
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Save Data Files (–s)

The –s option saves the data files after successful committal when the 
data directory and the marker directory are specified as different direc-
tories. The default is to delete the files. The –s option is used in addi-
tion to the –d (define data directory) and the –m (define marker 
directory) options. The –s option cannot be used alone. 

To save the data files when data and marker directories are different, 
enter the command below at the system prompt.

cold_3770 –d <data_dir> –m <marker_dir> –s

Command line example:

cold_3770 –d /fnsw/local/tmp/3770/data –m /fnsw/local/
tmp/3770/marker –s

Define Translation Table (–t)

The –t option specifies the user-defined character translation table to 
be used for processing the COLD data files prefixed with TX_. The –t 
option can be used on the command line alone or with other options. 
When using the –t option, you don’t need to specify the translation file’s 
full pathname, just the file name. 

The user defined character translation table must reside in the direc-
tory /fnsw/local/nltmaps. 

The –t option is not required on the command line. 

CAUTION Do not use this option if the translation file that you want to use has not 
already been created.
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To define a translation table for UNIX platforms:

Enter the command below at the system prompt:

nohup /fnsw/bin/cold_3770 –d <directory> –t <translat’n file> &

Command line example:

nohup /fnsw/bin/cold_3770 –d /fnsw/tmp –t hextohex &

To define a translation table for Windows Server platforms:

Enter the command below at the system prompt:

\fnsw\bin\cold_3770 –d <directory> –t <translation file>

Command line example:

\fnsw\bin\cold_3770 –d \fnsw\tmp –t hextohex

Define Polling Frequency (–p)

The –p option sets the daemon’s polling frequency. The –p option can 
be used on the command line alone or with other options.

The 3770 daemon’s default polling frequency is once every 60 sec-
onds. If this frequency is adequate, you don’t need to specify the –p 
option. To increase or decrease the frequency, enter the –p option fol-
lowed by the number of seconds you want between polling cycles. 

If you specify fewer than 60 seconds as a polling frequency, the 
daemon polls more frequently and can increase throughput. If you 
specify more than 60 seconds as a polling frequency, the daemon polls 
less frequently and can reduce throughput. The range commonly used 

UNIX

WIN
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is from 15 to 7200, although the possible range is much greater (0 to 
more than a billion).

When you enter zero, the daemon runs once and then exits. 

To define the daemon’s polling frequency, enter the command below at 
the system prompt:

cold_3770 –p <seconds>

Command line example:

cold_3770 –p 15

Display Usage Report (–h)

The –h option displays the syntax for the command. The –h option can 
be used on the command line alone or with other options. 

To display a usage report for the cold_3770 command, enter the fol-
lowing at the system prompt:

cold_3770 –h

Start the 3770 Daemon Automatically

If you want the cold_3770 daemon to start automatically every time 
you start the FileNet Image Services software, add the commands 
shown below to the appropriate file. To run the commands below, you 
must be a member of fnadmin or fnop, or log on using fnlogon. 

To start the 3770 daemon automatically on UNIX-based platforms:

1 Create an executable file named:

UNIX



3 Running an Import Job

Automating COLD

November 2008 COLD Handbook, Release 4.1.2 163

/fnsw/local/sd/ims_start

2 Enter the commands below in the file you created: 

echo  “Starting cold_3770 daemon”  >>  $OFILE
/fnsw/bin/sys_log “Starting cold_3770 Daemon”
nohup  /fnsw/bin/cold_3770 <options> > /dev/null  &
echo “Initialization of cold_3770 Daemon complete.” >> 
$OFILE

To start the 3770 daemon automatically on Windows Server-based 
platforms:

1 Create a batch file named:

\fnsw_loc\sd\ims_start.bat

2 Enter the commands below in the file you created: 

echo  “Starting cold_3770 daemon”
<drive>:\fnsw\bin\sys_log “Starting cold_3770 Daemon”
start /b <drive>:\fnsw\bin\cold_3770 <options>
echo “Initialization of cold_3770 Daemon complete.” 

Start the 3770 Daemon Manually 

If you want to run the 3770 daemon manually, enter the commands 
explained in the following procedures at the system prompt. To run the 
commands, you must be a member of fnadmin or fnop, or log on using 
fnlogon. 

WIN
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To start the 3770 daemon manually on UNIX-based platforms:

At a terminal attached to the server, enter the following at the com-
mand line:

nohup /fnsw/bin/cold_3770 <options> &

To start the 3770 daemon manually on Windows Server-based 
platforms.

At a terminal attached to the server, enter the following at the com-
mand line:

start/b <drive>:\fnsw\bin\cold_3770 <options>

Stop the 3770 Daemon

To stop the 3770 daemon on UNIX-based platforms, you must use the 
kill command.

To stop the 3770 daemon on Windows Server-based platforms, you 
must use the End Task option on the Task List menu. 

CAUTION Stopping the 3770 daemon will cause unrecoverable interruption to a 
running COLD process. Before killing a 3770 daemon, please make 
sure all the data in the data directory has been processed and that 
there are no pending processes.

Batch Committal
The import program commits the documents to a batch indicated by 
the job name. Each document has a header page and a maximum of 
1,000 pages per document. COLD uses fast batch committal, which 

UNIX

WIN

UNIX

WIN
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means that batches are committed directly to optical disk without tem-
porarily storing the images in cache. The Query Match Report can dis-
play COLD documents as soon as committal is complete. 

This type of committal does not let you retrieve and display document 
images contained in a batch until that batch is committed to optical 
disk. The batch committal program provides for shared access to the 
optical disk. 

COLD inserts index values through IS Document Services in the same 
way as other committed documents.

COLD committals are write requests, which are in the middle of the pri-
ority scale. See the table below for examples of job request priorities. 
The shaded row in the table indicates COLD’s default priority. 

Printing Job Files
It can be helpful to have a hard-copy record of the various components 
that go into running an import job in case you should ever have to 
recreate them. For a written record, you can use a copy of the Session 
Checklist on page 189, or you can print the ASCII COLD job files on a 
printer for a hardcopy record. COLD job files include: 

Priority Definition Example

1 High Priority Read A retrieval request for a document on optical media (top priority).

2 Medium Priority Read The next document in a Query Match Report.

3 Write Requests A document committal, including COLD.

4 Low Priority Read A prefetch request.

5 Background Job request An import or disk copy operation (lowest priority).
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Background template

Channel control

Report format

Import job

Import log

From the File menu in any of the above definition windows, select the 
Print command.

Job File Example

The following is an example of how the FN_DEFAULT channel control 
file looks when printed: 

Name FN_DEFAULT
Channel_description "Default Channel Control File"
Major_version 2
Minor_version 1
Magic 19283746
Number_of_channel_control 6
Character(inhex)    Spacing        Vertical Tab   Paging           Ignore 
Line
0x20                   1              NONE           NONE             NONE
0x30                   2              NONE           NONE             NONE
0x2d                   3              NONE           NONE             NONE
0x2b                   NONE           NONE           NONE             1
0x26                   NONE           NONE           NONE             1
0x31                   NONE           NONE           1                NONE
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Appendix A – COLD Data Formats

This appendix contains information on the following topics: 

• Input and output data formats

• Preprocessing and postprocessing

• Minimum and maximum values

Input Data Formats
COLD accepts text data from tape or disk in ASCII, EBCDIC, or other 
formats, depending on the source. If the data is in any format other 
than ASCII, COLD translates it to ASCII before writing it to disk. 
Because non-ASCII files must go through this translation, they take 
slightly longer to process than ASCII files.   

Note To prepare for an import session, detailed information is required for 
both disk and tape files. Use a checklist to make sure you gather all the 
information needed. See the checklist supplied on page 189.

Disk Files as Source

If the source of the input data is a disk file, have your customer service 
representative configure your system with a file system large enough 
to contain your files. You might want to create a file system partition 
called “miscellaneous” and mount it as /cold; then load all imported 
data files into this directory.
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Tapes as Source

To prepare for a COLD session, you need explicit information about the 
data on the tape. The following paragraphs can help to find the needed 
information, or you can request it from the company or department that 
writes the data. 

Tape Labels

The illustration below specifies where you can find the reel number, 
block size, and record size information on the tape:

Command examples for accessing tape information are as follows:

VOL1011009

HDR1ET.STMTS.G0079V0001393200080001007900 88247 000000000000IBM OS/VS 379

HDR2F098420013331 IDPFLNET/FILENET      B    67401

reel
number

block
size

record
size

Display the tape label. dd if=/dev/1/rmt0 bs=80 conv=ascii

Copy the tape label to a file. dd if=/dev/1/rmt0 of=/tmp/tapelabel bs=80 conv=ascii

Copy the label from a file to a new tape. dd if=/tmp/tapelabel of=/dev/1/rmt16 bs=80

Copy the data on a tape to a file. 
(/tmp/tapedata is the file name and
x is the block size.)

dd if=/dev/1/rmt0 of=/tmp/tapedata bs=x

Copy COLD data from a file to a new tape, 
where x is the block size:

dd if=/tmp/tapedata of=/dev/1/rmt0 bs=x
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See the System Administrator’s Handbook for more information about 
the dd command and its options.

Labeled Tapes

An import job can span several tape reels, but all the tapes must be 
labeled. 

Labels and data must be written on the tape in the following format:

CAUTION COLD processes the first tape in a multi-tape import job but, does not 
process the remaining tapes if they are unlabeled. COLD can process 
unlabeled tapes, but only one at a time.

BOT VOL HDR TM DATA TM EOV TM TM
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These format elements are described in the table below. 

Unlabeled Tapes

An unlabeled tape has the following format: 

The program expects data following the beginning of tape marker 
(BOT). It will continue processing data until it detects a double tape 
mark (TM TM) indicating the physical end of the tape.

Format Element Description

BOT
Beginning of Tape

The program starts reading data after the BOT marker and continues to read 
data until it encounters an end-of-volume (EOV) label or an end-of-file label 
(EOF). 

VOL
Volume Label

Each tape in a multi-volume set has a volume label indicating the serial 
number.

HDR
Header Label

The header label contains the tape number and a description of the data on 
the tape. The tape number links the tapes in a multi-volume set. The descrip-
tion of the data includes the format, the block length, and the record length 
(line length). 

TM
Tape Mark

A single tape mark precedes and follows the data. A double tape mark sig-
nals the physical end of the tape.

DATA
Data Blocks

Each data record begins with a printer control character (channel control 
character) and corresponds to a line of text. The program starts a new page 
when it has processed the maximum number of lines in a page, or when the 
printer control character is a 1, whichever occurs first.

EOF
End of File Label

When the program encounters an end-of-file label, it terminates.

EOV
End of Volume Label

When the program encounters an end-of-volume label, it prompts you for the 
next numbered tape. 

BOT DATA TM TM
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Importing EBCDIC & Other Character Sets to COLD

You can import EBCDIC data to COLD by specifying that COLD trans-
late this data to ASCII format. COLD provides the ebcdic_8859-1 char-
acter translation map for this purpose.

You select the translation map from within COLD’s Import Document 
function. For details on how to select a translation map. See “Import 
Documents” on page 145.

Define a Character Translation Map

You might also need to import data to COLD that is in a format other 
than EBCDIC. To do this, you must create your own character transla-
tion map in the following way:

• Create an ASCII file that maps the source character set to the des-
tination character set.

• Use the FileNet NLT_build_maps command to convert this ASCII 
file to binary format.

• From within COLD’s Import Document function, select the binary 
character translation map file.

The following paragraphs describe this procedure.

Create an ASCII File

Create an ASCII file that maps the source character set to the destina-
tion character set. This ASCII file consists of 256 records. Each record 
contains two columns. The left column contains the source character’s 
hexadecimal value. The right column contains the destination char-
acter’s hexadecimal value. 
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For example, the following record maps the character “A” from the 
EBCDIC character set to the ISO8859-1 character set. 

COLD ignores any characters following the second column. Use this 
area to enter descriptions of the character. Any record beginning with a 
# or space is a comment line.

Store the ASCII file in the /fnsw/local/nltmaps directory. 

Convert the ASCII file to binary format

Use the NLT_build_maps command to convert the ASCII file to binary 
format. The usage of NLT_build_maps is:

NLT_build_maps {–c | –v} –s<source_map> –n<normal_map> 
–i<inverse_map>

Source Character EBCDIC ISO8859-1

Capital letter A 0xc1 0x41

where:

–c Specifies that the translation map be created using <source_map>.

–v
Specifies that the binary translation map be verified as the correct output of 
the source. Use this parameter if you are noticing translation problems and 
want to check the validity of the binary file.

–s<source_map> Represents the name of the ASCII source translation file. Required.

–n<normal_map>
Represents the name of the binary translation map to be created or verified 
in the local directory using <source_map>.

–i<inverse_map>
Represents the name of an inverse translation map to be created or verified 
in the local directory using <source_map>.



Appendix A – COLD Data Formats

COLD Formatting During Data Processing

November 2008 COLD Handbook, Release 4.1.2 173

Make sure that you create the binary translation maps with a name that 
describes the nature and direction of the mapping. For example, the 
ebcdic_8859-1 file indicates that the map is from EBCDIC to the 
ISO8859-1 character-set.

After converting your ASCII character translation map to binary format, 
it is available for selection from within COLD’s Import Document func-
tion. For details on this procedure, See “Import Documents” on 
page 145.

COLD software automatically converts binary format job files from pre-
vious versions of COLD to ASCII format the first time you use Preview 
Documents, Import Documents, and cold_3770.

COLD Formatting During Data Processing 
At various times, you specify where certain information resides in your 
data. For example, you specify on which line or page to get:

Indexing information

Report ID literal

Start-of-Document indicators

Filtering information

Table of Contents key
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Before COLD applies any formatting to the data; it is raw data. After 
COLD applies the channel control character formatting, as described 
in “Format Data Using Channel Control Characters” on page 45, 
the data is now at least partially formatted, and the line and page num-
bers might be different from those in the raw data. This is prepro-
cessed data. During the import session, COLD applies other 
formatting that you have specified in the report format file.

So, which line and page numbers do you use when you specify that 
COLD should look on certain lines or pages for data, those for the for-
matted or the unformatted data?

This illustration helps to answer the question.

As the graphic illustrates, COLD finds start-of-document indicators, 
report ID literals, and applies channel control character formatting on 
the raw, unformatted data. 
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Preprocessing

When defining a channel control file and a report format, you specify 
the locations of the following data items relative to the raw data:

• The start-of-document indicator(s) indicates where a new variable-
length document begins.

• The channel control characters tell COLD to ignore a line or specify 
the spacing for a line.

• The report ID literal identifies the report format definition file.

Postprocessing

When defining a report format, you specify the locations of the fol-
lowing data items relative to the preprocessed data: 

• Lines and pages to be filtered out.

• Table of contents field.

• Index values.

If a channel control character on page 14 indicates that COLD should 
ignore that page, the data on page 15 becomes page 14 in the prepro-
cessed data. Similarly, a channel control character that causes lines to 
be double-spaced could cause data that was on line 36 to be posi-
tioned on line 72 in the preprocessed data.

When you indicate the locations of index values, table of contents keys, 
report IDs, etc., be sure to make any necessary allowances and 
adjustments for the formatting done by the channel control file.
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Start-of-document indicators are the only Report ID parameters where 
COLD searches the raw import data. Raw here means before channel 
control characters are applied. However, start-of-document indicators 
are applied after page filtering and might not generate expected docu-
ments. If an and/or start of document indicator appears on a filtered 
page, a new document is not triggered, and the page immediately fol-
lowing starts a new document only if the start-of-document indicators 
are different from the last unfiltered page.

Output Data Formats
COLD writes data to optical disk as ASCII text; it does not convert the 
data to image format. This means that COLD’s storage requirements 
are much smaller than for images processed by other FileNet software. 
For example, a typical text page is approximately 2KB, but an average 
image is 75KB. COLD saves more space by automatically com-
pressing blank lines in a text file. COLD saves even more space if you 
select the Enable Page Compression feature from the Define Report 
Format window.

The FileNet system stores background templates separately from the 
COLD data. The COLD data references the background templates so 
they display and print together.
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Appendix B – Disk Space Management

During processing, COLD generates a number of files that are either 
created and named by the user or by the software. You should periodi-
cally check your hard disk to make sure that obsolete COLD files are 
not taking up space unnecessarily. 

Managing Disk Space
The table below describes the files created by COLD and how you can 
remove them, except for the FN_DEFAULT channel control file. 

File File Name Directory — How to Delete It

Background
Template

User-defined
/fnsw/local/cold/templates
From the command line or within COLD (Define Background 
Templates).

Channel 
Control

FN_DEFAULT or
User-defined

/fnsw/local/cold/channel
Do not delete the channel control file, FN_DEFAULT. This 
file is the basis for other channel control files.

Report 
Format 

User-defined
/fnsw/local/cold/formats
From the command line or within COLD (Define Report 
Format).

COLD Data User-defined
User-defined directory
From the command line. COLD data files processed by the 
cold_3770 program are deleted automatically.

Import Job User-defined
/fnsw/local/cold/jobs
From the command line or within COLD (Define Import Job).
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Import Log 

log.jobid, where jo-
bid is the date-time 
stamp for the start of 
the job.

/fnsw/local/logs/cold
After you view this file, COLD asks you if you want to delete it. 
Can also be deleted from the command line.

Checkpoint 

ckp.jobid, where jo-
bid is the date-time 
stamp for the start of 
the job.

/fnsw/local/logs/cold
Automatically deleted by COLD when an import job success-
fully completes; otherwise, from the command line. Do not de-
lete a checkpoint file unless you are sure that it will not be 
needed to resume processing an interrupted job.

File File Name Directory — How to Delete It
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Appendix C – Performance Factors
& Restrictions

This appendix discusses some of the aspects of the COLD application 
that can impact performance, and other considerations that might 
restrict production. 

Performance Factors
COLD’s performance varies depending on a number of factors 
including (but not limited to) the following:

Input Source (Disk or Tape)

COLD processes files from disk faster than those from tape.

Space Required in Page Cache

In order to run, COLD needs 20MB of contiguous disk space in page 
cache. To process variable-page documents with variable-length lines, 
the minimum grows to 90MB. 

System Activity

Any activity on your system can affect COLD’s performance and cause 
documents to process more slowly.
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Type of Server

COLD performs best when running on a storage library server. You can 
also run COLD on an Index server, or on a Combined Storage Library/
Index server.

For optimum performance in a Dual server environment, run COLD on 
the storage library server.

Document Length

Long documents process faster than the same number of pages 
broken into short documents. For example, COLD processes a single 
100-page document almost four times faster than it processes 100 
one-page documents.

Number of Index Values per Document

The greater the number of index values, the slower the process.

Source of Index Values (Constants or Variables)

COLD must extract variable index values from the data, searching for 
them in specified locations. For this reason, variable index values can 
increase processing time.

Amount of Data per Page

The greater the amount of data per page, the slower the process.
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Variable- vs. Fixed-Length Documents

COLD processes variable-length documents more slowly than fixed-
length documents regardless of the number of pages per document. 
This is because the software must search each page to determine 
when to start a new document.

On the other hand, variable-length documents are limited to one docu-
ment class, so they might process faster than fixed-length documents 
using multiple document classes.

Variable- vs. Fixed-Length Records

As with variable- and fixed-length documents, the software must 
search each line to find an end-of-line sequence.

ASCII vs. non-ASCII Data

Because COLD must convert non-ASCII data to ASCII, the conversion 
process increases process time for non-ASCII data.

Table of Contents Processing

Because COLD must search the data for the table of contents key, 
table of contents preparation slows down COLD processing.

Filtering

Page and line filtering can take time if COLD must search the data for 
the search literals. However, filtered data requires less space on 
optical disk.
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Keyword Search

Because COLD must search every page if a page number is not spec-
ified, and every line if a line number is not specified, a keyword search 
for index values can impact performance.

Restrictions & Considerations
Some restrictions and considerations for using COLD are as follows:

Printer & Scanner Distortion

Some printers and scanners might distort an image slightly. To align 
COLD data on a background template, you must adjust the margins 
and font size. You might want to test the alignment of a template with 
your COLD data by printing it. (The laser printer does not alter the size 
of the printed image.)

Data Prints Outside Template Boundary

A local printer or FileNet printer can produce printed output with the 
data printed outside of the template boundary. Yet, the document 
appears normal when displayed. This can occur when using certain 
releases of WorkForce Desktop to print COLD documents. 

Restart an Interrupted Job

You must restart an interrupted import job by using the COLD import 
process.

You cannot restart a Preview Documents process.
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Maximum Characters Per Line

Each record yields one line of text. A line can contain a maximum of 
256 characters.

Scroll to See All Data

If the lines of data are too long to fit in a display window, you can scroll 
the screen to see all of the characters. If a line is too long to fit on one 
line, the printing software wraps the text to the next line.
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Appendix D – Table of Contents Examples

This appendix contains four examples of how a table of contents might 
display and print using the Gothic fonts.

Gothic 12
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Gothic 12
6.25 lines per inch (default)
with template



Appendix D – Table of Contents Examples

November 2008 COLD Handbook, Release 4.1.2 185

Gothic 9

Gothic 9
7.7 lines per inch (default)
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Gothic 8

Gothic 8
8.33 lines per inch (default)
with template

Index               Page
------------------- ----
4254785                2
4266801                3
4269247                4
4271478                5
4275606                6
4339727                7
4354719                8
4388493                9
4399406               10
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Gothic 6

Gothic 6
12.5 lines per inch (default)
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Appendix E – COLD Session Checklist

How a Checklist Helps You
Using a session checklist can help you: 

• Simplify gathering and referencing the varied information for an im-
port job.

• Provide a hard-copy record of each import job’s attributes in case 
you need to re-create job files. 

You can make a copy of the prepared checklist in this appendix or 
create your own. 

Another way to provide a hard copy record of your COLD session is to 
print the ASCII COLD job files on a FileNet printer. COLD job files 
include:

Background template
Channel control
Report format
Import job
Import log

To print the information above, select the Print command from the File 
menu in any of the above definition windows.
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Appendix F – Converting from COLD 1

Replace Document Creation Rules Files
To convert from COLD 1 to COLD 3.5.0, you must replace the COLD 1 
Document Creation Rules files with Report Format files and at least 
one Import Job file. There are two ways to do this:

• An easy conversion is to define a report format for each document 
class in an existing COLD 1 Document Creation Rules file. Each of 
the report formats will be identical, except for the index sources, 
which depend on the document class. You can then create an Im-
port Job file containing the names of the report formats.

• A more precise conversion is to define several report formats with 
the same document class, which provides for the indexing informa-
tion found in different locations in the document.

Channel Control File
If you are converting from COLD 1, you must use the FN_DEFAULT 
channel control file. The channel control characters that it contains are 
the only ones that were supported in COLD 1.

Start-of-Document Indicator
If you are converting from COLD 1, keep in mind that COLD 4.1.2 
looks for the start-of-document indicator(s) in the unformatted data 
(preprocessing). COLD 1 looked for the start-of-document indicator in 
the formatted data (postprocessing).
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Adjust WorkFlo Scripts
When creating the table of contents page, COLD 1 did not remove 
trailing blanks from lines. Beginning with COLD release 2.2, trailing 
blanks are automatically removed. If your WorkFlo scripts assume that 
COLD is not removing trailing blanks, the assumption must be 
removed.
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Appendix G – Miscellaneous Information

This appendix contains information on the various COLD directories 
and the minimum and maximum values for various data fields.

COLD Directories
The following table identifies where you can find the files created by or 
provided for using COLD.

Directory Name Directory Name What Is Stored There

/fnsw/local/tmp/3770 \fnsw_loc\tmp\3770
The default directory in which the daemon 
program searches for files containing COLD 
data.

/fnsw/local/cold/templates \fnsw_loc\cold\templates The templates’ definitions file.

/fnsw/bin \fnsw\bin
The commands that you can use to start 
COLD applications from the system prompt.

/fnsw/local/cold/config \fnsw_loc\cold\config
The configuration file for using a 400 dpi 
background template.

/fnsw/local/cold/channel \fnsw_loc\cold\channel
The user defined and the default channel 
control files.

/fnsw/local/cold/formats \fnsw_loc\cold\formats The Report Format files.
/fnsw/local/cold/jobs \fnsw_loc\cold\jobs The Import Job files.

/fnsw/local/logs/cold \fnsw_loc\logs\cold The Import Log and checkpoint files.

/fnsw/local/nltmaps \fnsw_loc\nltmaps The character translation table.

/fnsw/local/tmp/3770_skip \fnsw_loc\tmp\3770_skip
The names of data files that can’t be deleted 
but are not to go into a COLD import.

UNIX WIN
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Minimum & Maximum Values for COLD Data
The table below shows the minimum and maximum sizes of the var-
ious items that make up the COLD data. 

Data Item Minimum Maximum

Characters per line 1 character 256 characters

Description fields for job files 1 character 30 characters

Indexes per report format 1 index 224 indexes

Keyword 1 character 239 characters

Line filter literal 1 character 16 characters

Lines per page 1 line 150 lines

Name fields for job files 1 character 30 characters

Page filter literal 1 character 16 characters

Pages in fixed-length documents 1 page 1,000 pages

Report ID literal 1 character 30 characters

Start of document indicator 1 character 150 characters

Table of contents literal 1 character 30 characters

Template identifier literal 1 character 30 characters

Token count 1 character 24 characters

Token separator 1 character 1 character
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FileNet System Date Masks
The following table indicates the dates masks that are resident on the 
FileNet system. 

Mask Code Values Description

w
0–6 where 
0=Sunday and 
6=Saturday

Day of the week

dd  1–31 Day of the month

ddd 1–366 Day of the year (

day Sun–Sat Abbreviated day name

dayname Sunday–Saturday Full day name

mm 1–12 Month number

mon Jan–Dec Abbreviated month name

month January–December Full month name

yy 00–99 Last two digits of year

yyyy 0000–9999 Full four-digit year



Appendix G – Miscellaneous Information

FileNet System Date Masks

November 2008 COLD Handbook, Release 4.1.2 196

The date mask can include spaces and punctuation characters as sep-
arators. Below are some sample date masks and their resulting dis-
play.

Note You may experience errors while running jobs that use date strings 
padded with extra blanks. To get around this, you can create an empty 
trigger file on your server. The location of this file depends on your 
server type:

UNIX: /fnsw/local/sd/1/dti_old_sep

Windows: \fnsw_loc\sd\1\dti_old_sep

Date Mask Display

dayname, month dd, yyyy Tuesday, October 12, 1999

dd mon yyyy 12 Oct 1999

mm/dd/yy 10/12/99

ddd 285
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Glossary

Background Template
A background template is a scanned image that supplies fixed text 
and graphics. COLD uses the template to display or print with a 
page of data. COLD superimposes the data that it processes onto 
the background image, such as an invoice form. 

Case-Sensitive
Case-Sensitive means that when entering information on a 
command line, you must use specified upper- and lower-case char-
acters. Commands on UNIX-based systems are case-sensitive, 
whereas commands on Windows Server systems are not. 

Channel Control Character
The character in the first column of every line of data is the channel 
control character. This character is also called the printer control 
character. You can assign several formatting functions to the 
channel control character. For example, you can assign the number 
1 in the first column in the first row of data to trigger a page break. 

Character
In this manual, the term “character” means the single-byte English 
language letter, symbol, or digit.

COLD
COLD is the acronym for Computer Output to Laser Disk. 
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Document
When this manual mentions “document,” it refers to the compilation 
of formatted data that is committed to optical disk.

Filtering
You can use filtering to tell COLD to ignore a single line on a page, 
part of a line, or an entire page. For example, you might not need all 
the data in a file to produce an invoice. COLD does not display, 
print, or commit the filtered data. Ignored lines are not displayed. Fil-
tered pages or lines are displayed only in the Import (Raw) Data 
window. 

Import Job File
The import job file contains information such as which report format 
and channel control files to use for processing a specific set of data. 

Import Log
COLD generates a file containing information about an import job. 
The file can display start and stop times, pages processed, etc. 

Import Session
The import session consists of importing data from a disk file or 
tape. COLD then processes and commits the imported data 
according to the specifications that you set in the Import Job file. 

Index Value
An index value is a variable that COLD extracts from the import data 
and adds to the index database. You use the index value later to 
retrieve documents. For example, you might use an index value 
called “CustName” to retrieve a specific customer’s credit account. 
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Multi-byte Characters
Characters in most languages are represented by a single-byte of 
data. Some languages such as Japanese require two or more bytes 
(multi-byte) to represent a single NLS character.

Preprocessing & Postprocessing
These terms refer to when COLD applies your various formatting 
instructions to the data. For example, channel control character for-
matting is done before COLD extracts index values. 

Preview
Preview is a simulated import job. Before actually running a COLD 
import job, use the Preview application to make sure that the data 
output is formatted properly. 

Raw Data
This is data direct from the input source before channel control char-
acter formatting is applied.

Report Format
The Report Format contains the information that COLD uses to 
determine the content and the format of imported data. You define 
start-of-document indicators and index values in the report format. 

Search Literal
A literal is non-variable data that signals COLD to perform a pre-
determined function. One example of a search literal is the Report 
Format ID. COLD applies the appropriate formatting to the data 
when a search literal specified as the Report Format ID is found in 
the data. 
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Table of Contents
One to three pages at the beginning of a document that can direct 
you to information in the document, and includes the page number.

Template
See “Background Template.”

Threshold Year
The point where 2000 is added to a two-digit year. In other words if 
you choose 1968 as the threshold year, 2000 is added to all two-
digit years 00 through 68. 

Token Concatenation
A method of stripping spaces from around a set of words or charac-
ters using a token such as a tab or a space. 

Token Count
The number of words or set of characters used as an index value.

Token Separator
An alphanumeric character or punctuation used to separate the 
words or set of characters used as an index value.
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Notices

This information was developed for products and services offered in 
the U.S.A.

IBM may not offer the products, services, or features discussed in this 
document in other countries. Consult your local IBM representative for 
information on the products and services currently available in your 
area. Any reference to an IBM product, program, or service is not 
intended to state or imply that only that IBM product, program, or ser-
vice may be used. Any functionally equivalent product, program, or 
service that does not infringe any IBM intellectual property right may 
be used instead. However, it is the user’s responsibility to evaluate and 
verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject 
matter described in this document. The furnishing of this document 
does not grant you any license to these patents. You can send license 
inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, con-
tact the IBM Intellectual Property Department in your country or send 
inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
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2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or 
any other country where such provisions are inconsistent with 
local law: INTERNATIONAL BUSINESS MACHINES CORPORATION 
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF 
ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGE-
MENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. Some states do not allow disclaimer of express or implied 
warranties in certain transactions, therefore, this statement may not 
apply to you.

This information could include technical inaccuracies or typographical 
errors. Changes are periodically made to the information herein; these 
changes will be incorporated in new editions of the publication. IBM 
may make improvements and/or changes in the product(s) and/or the 
program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided 
for convenience only and do not in any manner serve as an endorse-
ment of those Web sites. The materials at those Web sites are not part 
of the materials for this IBM product and use of those Web sites is at 
your own risk.

IBM may use or distribute any of the information you supply in any way 
it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the 
purpose of enabling: (i) the exchange of information between indepen-
dently created programs and other programs (including this one) and 
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(ii) the mutual use of the information which has been exchanged, 
should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and 
conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed 
material available for it are provided by IBM under terms of the IBM 
Customer Agreement, IBM International Program License Agreement 
or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating envi-
ronments may vary significantly. Some measurements may have been 
made on development-level systems and there is no guarantee that 
these measurements will be the same on generally available systems. 
Furthermore, some measurements may have been estimated through 
extrapolation. Actual results may vary. Users of this document should 
verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the sup-
pliers of those products, their published announcements or other pub-
licly available sources. IBM has not tested those products and cannot 
confirm the accuracy of performance, compatibility or any other claims 
related to non-IBM products. Questions on the capabilities of non-IBM 
products should be addressed to the suppliers of those products.
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All statements regarding IBM’s future direction or intent are subject to 
change or withdrawal without notice, and represent goals and objec-
tives only.

This information contains examples of data and reports used in daily 
business operations. To illustrate them as completely as possible, the 
examples include the names of individuals, companies, brands, and 
products. All of these names are fictitious and any similarity to the 
names and addresses used by an actual business enterprise is 
entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source lan-
guage, which illustrate programming techniques on various operating 
platforms. You may copy, modify, and distribute these sample programs 
in any form without payment to IBM, for the purposes of developing, 
using, marketing or distributing application programs conforming to the 
application programming interface for the operating platform for which 
the sample programs are written. These examples have not been thor-
oughly tested under all conditions. IBM, therefore, cannot guarantee or 
imply reliability, serviceability, or function of these programs.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trade-
marks of International Business Machines Corporation in the United 
States, other countries, or both. If these and other IBM trademarked 
terms are marked on their first occurrence in this information with a 
trademark symbol (® or ™), these symbols indicate U.S. registered or 
common law trademarks owned by IBM at the time this information 
was published. Such trademarks may also be registered or common 
law trademarks in other countries. A current list of IBM trademarks is 
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available on the Web at "Copyright and trademark information" at 
www.ibm.com/legal/copytrade.shtml.

Microsoft and Windows are trademarks of Microsoft Corporation in the 
United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United 
States and other countries.

Other company, product, and service names may be trademarks or 
service marks of others.

U.S. Patents Disclosure
This product incorporates technology covered by one or more of the 
following patents: U.S. Patent Numbers: 6,094,505; 5,768,416; 
5,625,465; 5,369,508; 5,258,855.

www.ibm.com/legal/copytrade.shtml
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Symbols
!IXGEN_DONT_EDIT_THIS! 15

Numerics
1st TOC page and last TOC page 94

specifying indexing information 94
3770 daemon 154–164

command line options for COLD 157
error file 155
overview 25
overview of processing 155
starting automatically 162
starting manually 163
stopping 164

400 dpi template, print settings 39

A
acronym, COLD 15
action buttons 141
add templates 115
add/modify channel control file 51
Align button 141
align text 125
ASCII data format 167
ASCII vs. non-ASCII data, effect on 

performance 181
automating COLD 154–164

overview 25

B
background template 36–42

400 dpi 39
add to report format 116
create 38
default 114
defined 197
definition file 38
delete 120
directory 38
file 177
maximum number 115
modify 119
overview 22
storage 176

background templates 37
batch committal 165
beginning-of-page character 45
beginning-of-tape mark 170
binary format, converting 173
blank lines, number 45
blanks, trailing 192
buttons

action 141
Align 141
Go To 139
Run 139
Search 140
Single Step 139
Skip 140
Stop 141

Index
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C
case-sensitive, defined 197
change document class 32
channel control

character 43–54
add to file 51
defined 197
delete 54
formatting 44
ignore line 45
maximum number 44
meanings 45
modify 53
overview 24
paging 45
spacing 45
vertical tab 45

file 43–54
add/modify window 51
COLD 1 191
create new 48
default 44, 45, 46
directory 177
modify 49
name, import job 131
save 54
window 49

channel control file, default, edit 46
character set translation

importing other 171
map 171
preview document 136

character, defined 197
characters per inch 125

characters per line 129
checkpoint file

delete 178
directory 178

COLD
3770 command line options 157

define data file directory 159
define directories 158
define marker file directory 159
define polling frequency 161
define translation table 160
display usage report 162
save data files 160
stopping 164
syntax 158

command line codes, applications 36
data

file, directory 177
formatting, before or after 174
minimum/maximum values 194

defined 197
features 22
job files, deleting 177
limitations 28
main menu 35
preparing to use 31

COLD acronym 15
COLD software version 15
columns, table of contents 73
command line

codes to run COLD applications 36
options for cold 3770 daemon 157

commands
3770 daemon 163
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NLT_build_maps 172
tape information 168

commit to optical disk 165
compression, page 79

enable/disable 79
concatenation, token 99
configuration, input files 167
considerations on use of COLD 182
constant

index 87, 92
specifying indexing information 87

constant vs. variable indexes, effect on 
performance 180

convert, binary format files 173
converting from COLD 1 191
counter, line 46
create

background templates 38
channel control file 48

D
daemon, 3770 154–164
data blocks, tape 170
data file (See <Italic>input file.)
data formats 167
Database Maintenance 32
date mask

constant 87, 92
variable 92

date of publication 15
date, Y2K 88
defaults

background template 114
channel control file 44, 45, 46
fonts 123, 184

define background template 36
delete

channel control character 54
COLD job files 177
report format file 126
template file 42
templates 115

description, job 135
directories 193

3770 156
3770 default 155
background template file 38, 177
channel control file 177
character maps 172
checkpoint file 178
COLD 177
data files 167
import job file 127, 132, 177
import job name 135, 146
import log file 152, 156, 178
initfnsw.sh script 162
report format file 59, 126, 132, 177

disable compression 79
discard unsaved changes to template 

alignment 141
disk file

import job, restarting 149
input format 167
name

import 147
preview 137

disk space management 177
disk vs. tape input, effect on 

performance 179
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display documents
overview 26
preview 134

display import log 150
distortion, printer/scanner 182
document class

for report format 79
index values 32
information window 81
security, overview 25

document creation rules, converting to 
COLD 2 191

document format 106–126
command 106
window 107

document length, effect on 
performance 180

document, defined 198
document, indexing source 90
documents

fixed-length 61, 63
overview 23

import 145
performance

fixed-length 181
variable-length 181

preview 134
overview 26

variable-length 61, 63
overview 23

E
EBCDIC data

effect on performance 181
format 167

importing to COLD 171
edit default channel control file 46
enable compression 79
enable page compression 79
end-of-file label, tape 170
end-of-line characters 131
end-of-volume label, tape 170
error log 153
examples

end-of-line character 130
fonts 123

default 184
keyword 102
printout, FN_DEFAULT 166
start-of-document indicator 66, 67
table of contents 184
template use 22, 38

F
fast batch committal 165
features 21
features of COLD 22
files

background template 177
channel control 177
checkpoint 178
COLD data 177
import job 177
import log 178
job, printing 165
report format 177
template 177

filter mask 100
filtering

defined 198
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effect on performance 181
line, by line number 111
line, by search literal 112
line/page 110
page 110
pages 108, 109

fixed page 63
fixed-length documents 61, 63

overview 23
fixed-length line 129
flow chart, setup 30
FN_DEFAULT, channel control file 44, 46, 

177
fonts 123

default, examples 184
form, preprinted, as a template 38
formats

input data 167
storage (output) 176

formatting
data, using channel control 

characters 45
text 78, 121–126

ftp 25, 154
function codes 36

G
generate table of contents 77
Go To button 139
graphics (template) 38
grid, layout 39, 55

H
header label, tape 170
header page, committal 165

hexadecimal, end-of-line character 131
how to

log on to COLD (UNIX) 33
how to…

add a character to a channel control 
file 51

add a template to report format 116
align a template 142
create background template 38
create channel control file 48
create tables of contents 72–78
create the import job 127–131
define a fixed-length document 63
define a report format name 60
define a translation table, UNIX 161
define a translation table, Windows 

Server 161
define a variable-length document 68
define page dimensions 70
define polling frequency 162
delete a background template 120
delete a channel control character 54
delete background templates 42
delete report format 126
delete the import job 133
display report format window 58
display usage reports 162
edit a channel control file 49–54
enable/disable page compression 79
extract indexes from filtered pages 108
filter a line 111
filter a line, search literal 112
filter a page 109
filter a single page 110



Index

November 2008 COLD Handbook, Release 4.1.2 211

filter partial lines 113
find data using offset coordinates 101
generate a table of contents 77
ignore lines (channel control char.) 45
log on to COLD (NT) 34
modify a channel control character 53
modify background template 119
obtain index values by filter mask 100
obtain index values by length 98
obtain index values by token 

concatenation 99
paginate (channel control char.) 45
preview a job 135
print job files 165
restart an import job, disk file 149
restart an import job, multi-tape 150
save a report format 126
save data files 160
save the import job 132
select a background template 40
select a default background 

template 114
set up a page 121–126
specify a document class 80
specify a job name 128
specify a report ID literal 62
specify a specific line for data (vert. 

tab) 45
specify indexing information

source, constant 87
source, document 90
source, keyword 95
source, no value 93
source, run date 92

source, TOC 94
specify line spacing (channel control 

char.) 45
start 3770 daemon automatically, 

UNIX 162
start 3770 daemon automatically, Win-

dows Server 163
start 3770 daemon manually, UNIX 164
start 3770 daemon manually, Windows 

Server 164
start a new import job 146
stop the 3770 daemon 164
strip blank spaces 99
use 400dpi background template 39
view an import log 150

I
identification, index 97
ignore line character 45
image, background 37

storage 176
import documents 145–150

fixed-length line 129
restarting a disk file import job 149
variable-length line 130
window 146

import job 127–133
defined 198
directory 127
file, delete 177
file, when converting from COLD 1 191
name 128
start a new 146
window 127

import log 150
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defined 198
file, delete 178

import session 198
import source (See <Italic>input source.)
index

constant 87, 92
identification 97
information 80
key value in table of contents 75
name 82
no value 93, 94
source 82
table of contents keys 74
type 82
values

defined 198, 199
document class 32
effect on performance 180
length 98

indexing information 84
indexing, overview 23
info message 137, 148
input data formats 167–173
input file

name 137, 147
source (import) 147

input source 136
tape 136

J
japanese data 27
job description 129, 135
job file, example 166
job files, printing 165
job name 135

committal 165
import 146

K
keyword

examples 102
search, effect on performance 182
specifying indexing information 95

L
labels

end-of-file, tape 170
end-of-volume, tape 170
header, tape 170
volume, tape 170

labels, tape 168
layout grid 39, 55
length, index value 98
line counter 46
line filtering

by line number 111
by search literal 112
effect on performance 181
page 110
partial 113
postprocessing 175

line length
fixed 129
maximum 183
variable 130

line spacing 45
lines per inch, printing 124
lines per page 70
literal, search, defined 199
log file name 152
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log on 33
to COLD on NT server 34
to COLD on UNIX server 33

M
main menu 34, 35
margin settings 125
mask, filter 100
matched string location field 140
maximum

characters per line 194
indexes per report format 194
length

description fields 194
keyword 194
line filter literal 194
name fields 194
page filter literal 194
report ID literal 194
start-of-doc indicator 194
table of contents literal 194
template identifier literal 194
token count 194
token separator 194

line length 183
lines per page 194
pages 194
pages, with table of contents 24

message, info 137, 148
minimum

characters per line 194
indexes per report format 194
length

description fields 194
keyword 194

line filter literal 194
name fields 194
page filter literal 194
report ID literal 194
start-of-doc indicator 194
table of contents literal 194
template identifier literal 194
token count 194
token separator 194

lines per page 194
pages 194

minus sign, and filter mask 100
modify

channel control file 49, 53
document class 32
templates 115, 141

multi-byte character 27
multi-byte character support 27
multiple index keys 74
multiple templates 116

window 116
multi-tape import job, restart 150
multi-volume tape 137

N
names

index 82
input file 137, 147
job 135
log file 152

naming conventions for transferred files 156
new page character 45
NLT_build_maps command 172
no value index 93, 94
NT server, log on to COLD 34
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O
offset coordinates 101
offset margin 125
online template alignment 141
output data formats 176
overview of 3770 daemon processing 155

P
page cache, space required 179
page compression 79

enable/disable 79
page filter 109, 110, 175

effect on performance 181
page setup 121–126

window 121
pages per document 63
part number, this manual 15
partial line filter 113
performance issues 179–182
plus sign, and filter mask 100
polling frequency 161
postprocessing 173, 191

defined 199
preparing to use COLD 31
preprocessing 173, 191

defined 199
preview documents 125, 134–144

character set translation 136
defined 199
info message 137
input source 136
overview 26
preview window 138
seek methods 139
template alignment 141

window 26, 135
print text width 71
printer control character 24
printing job files 165
priorities, committal 165
prompts, log on 33
publications, other 16

Q
quantity of data on page, effect on 

performance 180

R
raw data, defined 199
rcp 25, 154
records, performance

fixed-length 181
variable-length 181

reference materials 16
related publications 16
report format 55–126

add template 116
committal attributes 71–76
compression, page 79
converting from COLD 1 191
defined 199
delete template 120
description 60
document attributes 62–71
document class 79

indexes 80
document format command 106
file, delete 126, 177
ID literal 60
line filtering 110
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lines per page 70
modify template 115, 119
name 59
overview, window 58
page compression 79
page filtering 110
page setup 121
print text width 71
save 126, 132
starting output column 71
start-of-document indicator 191
table of contents, enable 72
template 114
window 58

report ID, location in COLD data 175
report, error 153
resolution, template 39
restart

a disk file import job 149
multi-tape import job 150

restrictions on use of COLD 182
RJE gateway 25
RJE/SNA services 154
Run button 139
run COLD from the system prompt 36
run date, specifying indexing information 92

S
save

channel control file 54
report format file 126, 132
template alignment 141
template file 41

scanned documents, document class 80
Search button 140

search literal, defined 199
second table of contents 74
security, document class, overview 25
seek methods, preview documents 139
server type, effect on performance 180
session log 150
setup flow chart 30
Single Step button 139
single-byte character 27
skill level required 15
skip a line 45
Skip button 140
sorting data, table of contents 74
sorting, table of contents 106
source

index 82
input 136

source of input file (import) 147
space management, disk 177
spacing 52
spacing, line 45
specify a job name 128
specify indexing information 90
start a new import job 146
start new page, channel control 45
starting output column 71
start-of-document indicator

COLD 1 191
multiple 68
preprocessing 175

Stop button 141
stopping the COLD 3770 daemon 164
storage format 176
storage space 176
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strip blank spaces 99
system activity, effect on performance 179
system main menu 34
system prompt, run COLD from 36

T
tab, vertical 45
tabbing 52
table of contents

command (Edit Menu) 73
effect on performance 181
enable 72
examples 184
generate 77
index keys 74
key 73
layout 75
margins 125
overview 24
postprocessing 175
sorting 106
sorting data 74
template 78
window 77

tape
commands 168
file name 137, 147
format 167
input source 136

tape service 136
labels 168
mark 170
multi-volume 137
service (import) 147
unlabeled 170

tape vs. disk input, effect on 
performance 179

template
align 142

templates 36–42
400 dpi 39
add to report format 116
align 141
default 114
defined 197
delete 42, 120, 177
directory 38, 177
identifier window 116
maximum number 115
modify 119
multiple 116
overview 22
storage 176
table of contents 78

third table of contents 74
threshold year 88
TIFF images as background templates 38
token concatenation 99
total warnings 153
trailing blanks, remove 192
transferred files, naming conventions 156
translation table 156, 157, 160
type, index 82
typeface 123

U
unattended operation of COLD (See 

<Italic>automating COLD.)
UNIX file system, configure 167
unlabeled tapes 170
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V
variable vs. constant indexes, effect on 

performance 180
variable-length documents 61, 63

overview 23
variable-length line 130
verify output 134

overview 26
version of COLD software 15
vertical tab 45
vertical tabbing 52
view import log 150–151

window 150
volume identifier

tape service 137
tape service (import) 147

volume label, tape 170

W
warnings, errors 153
windows

add/modify channel control 51
define background template 40
define channel control file 49
define report format 58
document class 81
document format 107
import documents 146
import job 127
multiple templates 116
page setup 121
preview COLD pages 26
preview documents 135
table of contents 77
template identifier 116

view import log 150
WorkFlo

trailing blanks 192

Y
year 2000 date 88
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